Oracle Applications Cloud

Using Common Features

21D
## Contents

### Preface

1. **Get Started**
   - About This Guide
   - Computer and Other System Requirements
   - Sign In and Get Started
   - Sign Out and Session Timeout
   - Overview of Work Areas
   - Change Your Password
   - Work as a Proxy
   - FAQs for Getting Started

2. **Search**
   - Overview of Search
   - Global Search
   - Page-Level Search

3. **Watchlist**
   - Overview of Watchlist
   - Create Watchlist Items
   - FAQs for Watchlist

4. **Notifications and Approval Workflows**
   - Overview of Notifications and Approval Workflows
   - Actions and Statuses for Workflow Tasks
   - View and Act On Notifications
   - Use Your Worklist to Manage Workflow Tasks
   - Define Vacation Rule for Workflow Tasks Assigned to Me
   - FAQs for Notifications and Approvals
   - Monitor and Troubleshoot Transactions
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5 Tables</strong></td>
<td>43</td>
</tr>
<tr>
<td>How You Use Tables</td>
<td>43</td>
</tr>
<tr>
<td>Query By Example</td>
<td>44</td>
</tr>
<tr>
<td>Export to Excel</td>
<td>46</td>
</tr>
<tr>
<td><strong>6 Excel Add-Ins</strong></td>
<td>49</td>
</tr>
<tr>
<td>Oracle ADF Desktop Integration Add-In for Excel</td>
<td>49</td>
</tr>
<tr>
<td>Oracle Visual Builder Add-In for Excel</td>
<td>51</td>
</tr>
<tr>
<td><strong>7 Attachments</strong></td>
<td>53</td>
</tr>
<tr>
<td>How can I delete attachments?</td>
<td>53</td>
</tr>
<tr>
<td>Can I view attachments in a different format?</td>
<td>53</td>
</tr>
<tr>
<td>How can I filter attachments?</td>
<td>53</td>
</tr>
<tr>
<td>What happens if I update an existing attachment?</td>
<td>53</td>
</tr>
<tr>
<td><strong>8 Data on Application Pages</strong></td>
<td>55</td>
</tr>
<tr>
<td>How can I print the data in the page I am on?</td>
<td>55</td>
</tr>
<tr>
<td>Why can't I see all the values I expect in my list of values?</td>
<td>55</td>
</tr>
<tr>
<td>How can I locate flexfields on a page?</td>
<td>55</td>
</tr>
<tr>
<td>Enter or Edit Translated Text</td>
<td>55</td>
</tr>
<tr>
<td>What's the difference between Language and Source Language?</td>
<td>56</td>
</tr>
<tr>
<td><strong>9 Scheduled Processes</strong></td>
<td>57</td>
</tr>
<tr>
<td>Overview of Scheduled Processes</td>
<td>57</td>
</tr>
<tr>
<td>Process Sets</td>
<td>57</td>
</tr>
<tr>
<td>Submit Processes</td>
<td>58</td>
</tr>
<tr>
<td>Manage Processes and View Output</td>
<td>61</td>
</tr>
<tr>
<td>FAQs for Scheduled Processes</td>
<td>69</td>
</tr>
<tr>
<td>Where to Find Information About Specific Scheduled Processes</td>
<td>70</td>
</tr>
<tr>
<td>Where to Find Information About Common Scheduled Processes</td>
<td>70</td>
</tr>
<tr>
<td><strong>10 Transactional Business Intelligence (OTBI) Analyses, Dashboards, Reports, and Infolets</strong></td>
<td>73</td>
</tr>
<tr>
<td>Reporting and Analytics: Overview of Analyses, Dashboards, Reports, and Infolets</td>
<td>73</td>
</tr>
<tr>
<td>View Analytics, Reports, and Dashboards</td>
<td>74</td>
</tr>
<tr>
<td>Where to Find More Information About Analytics and Reports</td>
<td>76</td>
</tr>
<tr>
<td>Infolets</td>
<td>77</td>
</tr>
</tbody>
</table>
# Social Network

Why should I care about social networking in my application? 81
What does social networking have to do with my job? 81
Where to Find Information About Social Networking 81

# Audit

Audit History 85
Types of Audit Events 86

# Troubleshoot

Troubleshoot Issues 87
Diagnostic Tests 87
Record Issues to Troubleshoot 91
FAQs for Troubleshooting 92

# Help

Get Help in the Application 95
Find Guides, Readiness Material, and Other Resources 96

# Preferences

Set Your General Preferences 99
Set Language Preferences 99
Change Your Photo 99
Set Up the Accessibility Modes 100
Change Your Password 101
Proxies 101
Watchlist 102

# Accessibility

Overview of Application Accessibility 105
Accessibility Features 105
Keyboard Shortcuts 106
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Help

Use help icons 🎈 to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons.

If you don't see Show Help Icons in the Settings and Actions menu, you can access the Oracle Help Center to find guides and videos.

Watch: This video tutorial shows you how to find and use help.

You can also read about it instead.

Additional Resources

• Community: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.

• Training: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website. Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.

Diversity and Inclusion

Oracle is fully committed to diversity and inclusion. Oracle respects and values having a diverse workforce that increases thought leadership and innovation. As part of our initiative to build a more inclusive culture that positively impacts our employees, customers, and partners, we're working to remove insensitive terms from our products and documentation. We're also mindful of the necessity to maintain compatibility with our customers' existing technologies and the need to ensure continuity of service as Oracle's offerings and industry standards evolve. Because of these technical constraints, our effort to remove insensitive terms is ongoing and will take time and external cooperation.

Contacting Oracle

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Oracle Accessibility Learning and Support if you are hearing impaired.

Comments and Suggestions

Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Get Started

About This Guide

This guide is for anyone who’s using the application, which means you! Use it to learn how to do general tasks that apply to some or all product families. If you’re looking for product-specific information, refer to the product-specific guides.

**Note:** You might come across information in this guide that applies only to certain pages or products.

Computer and Other System Requirements

Before using Oracle cloud applications in browsers and on your mobile devices, check the operating systems, supported browsers, and other computer requirements. For information about system requirements, see https://www.oracle.com/system-requirements/. For previous releases, scroll to the end of the page and find the system requirements link for the applicable previous release.

**Related Topics**

- System Requirements for Oracle Applications Cloud

Sign In and Get Started

Use the application link your company gave you to open the Sign In page. Depending on the configuration done by your IT Security Manager, you can sign in using one of these methods:

- Enter your application user ID and password.
- Click the **Company Single Sign On** button and sign in using your Single Sign-On (SSO) credentials. By using SSO, you can seamlessly access different applications without having to authenticate yourself each time.

Home Page

Your home page shows a global header, which you can find on every page of your application. The global header contains some icons, the Navigator, and the Settings and Actions menu. You can use them to get to the tasks you want to accomplish.

You can use the work area icons in the Apps section of your home page to get to the work areas and do your tasks. If you don’t find any work area icons in the Apps section, look for them in the Navigator. That’s because the Navigator contains the full list of work areas that you have access to. Related work area icons are arranged in specific groups in the Navigator. These groups appear as tabs in the Apps section.
Here's how your home page looks, with the default news feed layout.

![Home page image](image_url)

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>UI Element</th>
<th>What You Use It For</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Navigator</td>
<td>Open any of the work areas that you have access to.</td>
</tr>
<tr>
<td>2</td>
<td>Other global header functionality</td>
<td>Use tools such as Global Search, Watchlist, and Favorites to see or get to what you need to work on. At any point, if you want to return to your home page from any page, you can click the <strong>Home</strong> icon or the logo in the global header.</td>
</tr>
<tr>
<td>3</td>
<td>Settings and Actions menu</td>
<td>Do some general tasks, for example, change your preferences, show help icons if they're hidden, and sign out. Click your user image or name to open this menu.</td>
</tr>
<tr>
<td>4</td>
<td>Tabs</td>
<td>See a set of work area icons and quick actions for a related set of tasks. These tabs correspond to groups in the Navigator.</td>
</tr>
<tr>
<td>5</td>
<td>Work area icons in the Apps section</td>
<td>Open your work areas from the group of icons on the home page. For example, click the <strong>Getting Started</strong> icon to open the Getting Started work area, where you can see materials that help you get going in the application. You can also show or hide specific work area icons using the <strong>Personalize Springboard</strong> icon.</td>
</tr>
</tbody>
</table>
Here are a few things to know:

- What icons you see in the Apps section depends on the tab you select.
- If you're looking for any standalone work area, such as Setup and Maintenance, check in the Others tab.
- If you can't see any tabs, it means you just have one visible group. In such cases, all work area icons in that group appear at the top level in the Apps section.

**Quick Actions section**

Go straight to some key tasks in the selected group. You can use Show More to see all quick actions in each group sorted alphabetically.

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>UI Element</th>
<th>What You Use It For</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Quick Actions section</td>
<td>Go straight to some key tasks in the selected group. You can use Show More to see all quick actions in each group sorted alphabetically.</td>
</tr>
</tbody>
</table>

**Note:** You might see changes in icons, colors, and shapes of some UI components.

You might also find some important information displayed in specific sections of your home page. This table lists the sections and describes what you use them for.

<table>
<thead>
<tr>
<th>Section</th>
<th>What You Use It For</th>
</tr>
</thead>
<tbody>
<tr>
<td>Things to Finish</td>
<td>View a list of your open notifications, and take required actions. For example, you can approve or reject a new notification even without opening it.</td>
</tr>
<tr>
<td>News and Announcements</td>
<td>Read all relevant news, such as articles, events, and insights.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> What information you see in this section depends on your user role.</td>
</tr>
<tr>
<td>Analytics</td>
<td>View infolets, mostly arranged in tabs. If you see an infolet's content at the top level (without any tabs), that means you have just one visible infolet. An infolet is a small interactive widget that gives you key information and shows you what's going on in the areas you work on. You might also find something that you need to follow up on.</td>
</tr>
</tbody>
</table>

**Note:** If you see different section names in your home page, that's because your administrator renamed them while setting up your home page.
Ways to Find Key Tasks in the Global Header
Let's take a closer look at how to find key tasks using the icons in the global header.

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>UI Element</th>
<th>What You Use It For</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Global Search</td>
<td>Find what you want to work on and open the corresponding page from the search results.</td>
</tr>
<tr>
<td>2</td>
<td>Home</td>
<td>Return to the home page.</td>
</tr>
<tr>
<td>3</td>
<td>Favorites and Recent Items</td>
<td>Bookmark pages or go back to those you recently opened.</td>
</tr>
<tr>
<td>4</td>
<td>Watchlist</td>
<td>Open pages for key items that you're tracking.</td>
</tr>
<tr>
<td>5</td>
<td>Notifications</td>
<td>See informational messages and tasks that you must act on.</td>
</tr>
<tr>
<td>6</td>
<td>Settings and Actions menu</td>
<td>Here are a few tasks you can do:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Set your preferences. For example, change your password or set your language and accessibility preferences.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Switch to use the application as someone else, if you’re authorized to do so.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Help troubleshoot problems if you run into any.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The options you see in this menu depend on your role. For example, an administrator can see more options to configure the application.</td>
</tr>
</tbody>
</table>

**Note:** The Search, Favorites and Recent Items, and Watchlist icons aren’t available for certain product families.

Other Home Page Layouts
If your home page looks different, don't worry! That’s because your administrator chose your home page layout as panel or banner, or a news feed layout with a different look and feel.
Here's a news feed layout with a different look and feel.

[Image of news feed layout]

And here's the panel layout. The banner layout looks similar, but a horizontal banner appears in the upper region of the home page.

[Image of panel layout]

Whichever layout you're using, you can do similar tasks but some UI elements you use to do your tasks look different in the panel or banner layout. Let's take a look at such UI elements.
### Related Topics
- Change Your Photo
- Configure Infolet Display
- Overview of Configuring Themes and Home Page Settings
- How You Use and Personalize Infolets in Oracle SCM and Procurement Cloud

### Sign Out and Session Timeout

After you complete your tasks, you can sign out of your application. However, sometimes you might get automatically signed out due to session timeouts.

Let's understand how session timeouts work. When you sign in using your credentials, you're authenticated to use the application, and a session is established. During this session, you don't need to re-authenticate. But, for security purposes, your session is configured to be active for a predefined duration, which is called session timeout period. Your sessions can expire due to various reasons such as, leaving your application idle for a period longer than the timeout period. In such cases, you're automatically signed out of the application. Your timeout periods may vary on certain
pages. For example, you may observe a longer timeout period on pages that automatically refresh, or UIs that open up in separate windows or tabs.

This table lists the various types of session timeouts you may experience. After the specified duration, your session expires, and you need to sign in again to continue your work.

**Note:** Session timeouts are predefined and can’t be edited.

<table>
<thead>
<tr>
<th>Timeout Type</th>
<th>Description</th>
<th>Timeout Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Lifetime Timeout</td>
<td>Once you’re authenticated in the application, if you’re actively working on it, your session remains active for a predefined duration, referred to as the session lifetime timeout period. Your session ends after this period, even if you’re using the application.</td>
<td>8 hours</td>
</tr>
<tr>
<td>Session Inactivity Timeout</td>
<td>This type of timeout considers the time elapsed since you last sent a request, for example responded to a poll or submitted a form, to the application server. After this duration, you get a message and an option to extend the session. If you don’t extend the session, you are signed out of it.</td>
<td>10 minutes</td>
</tr>
</tbody>
</table>
| Idle Session Timeout       | This type of timeout considers the duration you leave your application idle for. After this duration, you get a message and an option to restart the session.  
  • If you restart the session, your session timeout duration gets reset.  
  • If you don’t restart the session, you’re signed out of the application. | 30 minutes       |
| Browser Inactivity Timeout | This type of timeout considers the duration you leave your browser idle for. After this duration, your session ends.                                                                                       | 30 minutes       |

**How Different Session Timeouts Work**

If you’re actively working on your application, your session remains active until the session lifetime timeout period, which is eight hours. However, session inactivity timeout considers the time elapsed since you last sent a request to the application server. For example, responded to a poll or submitted a form. These requests are sent to server at regular intervals and the session inactivity timeout will not happen. But here are a few scenarios when the poll or active data service requests will be stopped, and the browser inactivity timeout happens.

- If you leave your browser idle for more than 30 minutes.
• If you don’t use the keyboard or mouse for more than 10 minutes. For example, if the server-side session timeout is 30 minutes, and the polling timeout parameter is set to 10 minutes, then the session expires if the user remains inactive for more than 40 minutes.

Best Practices for Minimizing Timeouts
Here are a few things to keep in mind:
• Sign in to only one active application instance.
• Don’t sign in to the application in multiple browsers simultaneously.
• Don’t sign in to the application in multiple tabs of the same browser simultaneously.

Sign Out
Once you’re done working in your application, you can sign out using the Settings and Actions menu. Click your user image or name to open this menu, and select Sign Out and then click Confirm to sign out of the application.

Overview of Work Areas

A work area is a set of pages that provides everything you need to accomplish a business goal.
You can use work area icons on your home page or the Navigator to open work areas. When you open any work area, you see a landing page. Landing pages typically summarize data and let you drill down to more details. Often you can change the records that you view by running different searches or filters, or by clicking an infotile, if any on the landing page. Let’s explore a couple of work areas.

Landing Pages with Searches and Filters
Some landing pages have filters you can use to view specific set of records that you’re looking for. For example, you can remove some values to exclude records that you don’t want to see, and then hide the filters. You can also use the search to find what you need. You can select the Actions menu to get going with a few tasks on the specific records, or open the record to see or edit details on another page.
Here's a landing page of a work area, where you use searches (1) and filters (2) to view specific records, and the **Actions** menu (3) to do your tasks.

![Image](image1.png)

Sometimes, you might find this record in the form of a grid or list. You can use the **Grid** icon and the **List** icon to switch between these two views of the same records.

**Landing Pages with Quick Access to Key Tasks**

Now let's see another work area where you get quick access to a set of related tasks. On these landing pages, you easily see the key tasks you can do in the work area.

Here's a landing page of a work area, where you can quickly access the key tasks (1).

![Image](image2.png)
Landing Pages with Infotiles

Other than filters and searches, there are other ways for you to get to what you need to work on.

Some landing pages show the work areas with infotiles, which display key information about a set of records. You can click links in the infotile to filter the records. For example, you can see the list of items you need to act on.

This table shows the available UI elements on the landing page and explains what you use them for.

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>UI Element</th>
<th>What You Use It For</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Row of infotiles</td>
<td>Display key information about a set of records, such as expense items and expense reports.</td>
</tr>
</tbody>
</table>
| 2             | Summary table    | • View records for the infotile you select.  
• Drill down from the landing page to a specific record. |
| 3             | Panel tab        | Do additional tasks, such as use the links to go to related tasks or view reports. |

Some landing pages have tabs on the left you can use to go to another page in the same work area. Here's a landing page of a work area with tabs on the left (1).
Landing Pages with Infolets

Some landing pages consist of only infolets. This is what a landing page with infolets looks like.

This is what a landing page with infolets looks like.

From an infolet, you can usually open other pages in the same work area or another work area.

There are many other types of work areas, which you can explore!

Related Topics

- How You Use Tables
- Overview of Infolets

Change Your Password

After you sign in, you can change your password for better security.

**Note:** You can't change your Single Sign-On (SSO) password using these steps.
1. Click your user image or name in the global header, and on the Settings and Actions menu, select Set Preferences.
2. In the General Preferences section, click Password, and enter your password details.
3. Click Save and Close.

Work as a Proxy

You must have the Impersonate User (FND_IMPERSONATE_USER_PRIV) privilege to work as a proxy, which means on behalf of another user.

1. Click your user image or name in the global header.
2. Click Switch To and select the user you want to work on behalf of.
3. Enter your password.
4. Click Confirm. You’re ready to work as a proxy.

As a proxy, you can access all the data and tasks of the actual user. All the tasks you do are logged as though the actual user worked on them. After you’re done working as that user, switch to another assigned account, or sign out and sign back in to your own account.

FAQs for Getting Started

What do I do if I can't find work area icons on the home page or the Navigator?

Here are a few things to know.

• If you can’t find a work area icon on the home page, look for it on the Navigator. The Navigator is the main menu, where you can open all the work areas you have access to.
• If you're using a mobile device, you might not find some work area icons on the home page or the Navigator because your administrator has disabled them.
• If you're looking for any standalone work area, such as Setup and Maintenance, check in the Others tab.

How can I show or hide work area icons on my home page?

You can show or hide the work area icons you use to navigate in the application. To do so, click the Personalize Springboard icon in the Apps section of your home page, and select or deselect the work area icons that you want to show or hide in that section. You can’t personalize the content of the Navigator.

If your home page layout is panel or banner, click the Personalize Springboard icon on the home page, and select or deselect the work areas icons to show or hide them.

Related Topics

• Overview of Configuring Themes and Home Page Settings
How can I reset my changes to the visibility settings of the work area icons on my home page?

In the Apps section of your home page, click the **Personalize Springboard** icon, and then on the Apps page, click **Reset**.

If your home page layout is panel or banner, click the **Personalize Springboard** icon on your home page, and click **Reset to Default** on the Personalize Springboard page.

Why can't I see some icons in the global header?

That's because the **Favorites and Recent Items** and **Watchlist** icons aren't available for certain product families.

**Related Topics**
- Overview of Configuring Themes and Home Page Settings

Why can't I see announcements on my home page?

That's because your administrator has either disabled announcements or not created any announcements.

**Related Topics**
- Create and Enable Announcements
- Define Home Page Appearance

Why are work area icons appearing at the top level instead of appearing within a group on the home page with panel or banner layout?

By default, some work area icons appear after you click the corresponding group icon on the panel or banner layout of your home page. But depending on what you have access to, these work area icons can actually appear at the top level (not in a group) as described in this table.

<table>
<thead>
<tr>
<th>What You Have Access To</th>
<th>How You See Work Area Icons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only one work area within a specific group</td>
<td>That one icon is displayed at the top level</td>
</tr>
<tr>
<td>Less than 16 work areas total, with duplicate work areas, that means, multiple work areas with the same name</td>
<td>These work area icons appear in their respective groups</td>
</tr>
</tbody>
</table>
### Why can't I see the filmstrip of work area icons on my page?

That's because of any of these reasons.

- You're in a news feed layout.
- Your administrator has disabled the filmstrip.
- The work area you're in doesn't have any related work areas.

### What determines the work area icons that appear on the filmstrip?

Here are some scenarios that determine the content of the filmstrip when you're using a panel or banner layout.

- The filmstrip includes icons for all the work areas within the group, even any work area icons that are currently hidden on the home page.
- The filmstrip doesn't appear at all if the work area you use has no related work areas within the group.
- If all work area icons appear at the top level on the home page, then those icons appear in the filmstrip for all the pages.

### Why can't I see the map for contextual addresses?

That's because of either of these reasons:

- Probably you have enabled the pop-up blocker for your browser, and so you can't see the map when you click the contextual address icon. The contextual address is marked with an orange triangle, the More icon. When you hover over the triangle, an icon appears, which you can click to display the address on a map. To resolve this issue, disable the pop-up blocker in your browser settings and try again.
This figure shows a work address with the contextual address icon.

<table>
<thead>
<tr>
<th>Work Address</th>
<th>Road Number 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sacramento, 95841</td>
</tr>
<tr>
<td></td>
<td>UNITED STATES</td>
</tr>
</tbody>
</table>

- Your administrator hasn’t yet set up the mapping service for contextual addresses.

Related Topics
- Set Up the Mapping Service for Contextual Addresses
2 Search

Overview of Search

You can use global search and page level search functionality to find specific information across the application.

- Global Search: use the search in the global header to quickly find something based on keywords across many business objects or categories. You can also use global search, if you don't have more specific criteria to search. When enabled, the global search is available no matter which page you're on.

- Page Level Search: use the searches on the pages where you do your work to find specific objects by entering multiple, detailed criteria. Some pages also have keyword searches that let you quickly search for the same business object.

You can save any search you do on a page as a new saved search and can manage the saved searches available to you. Use filters to narrow down the list displayed in your work area, focus your search, and explore your data. You can use the Show Filters option to view the predefined filters for the saved search you selected.

Global Search

Examples of Using Wildcards and Quotation Marks in Global Search

The following scenarios provide examples of using wildcards or quotation marks in global search. Actual search results may vary, depending on factors such as how the search is set up or what data is available. For example, if you enter account ID as the search term, you should get all records with both words. But if there are no results with both words, then you get records with only one of the words.

Note: The global search:
- Is not case sensitive
- Ignores characters that aren't in the indexed language

Using Quotation Marks
Enter multiple words with quotation marks to get records that have the exact phrase. For example, if you search for "currency code", then only records with the exact phrase currency code are included in the search results.

Using Wildcards
Use the asterisk (*) wildcard to get records that replace the wildcard with zero or more characters. Use the question mark (?) to replace the wildcard with exactly one character.

- Enter the wildcard in the middle or at the end of a search term.
- To include * or ? in your search results, precede the symbol with a backslash (\) when you enter the search term. The symbol won't act as a wildcard, but as any other character in your search term.
This table shows some wildcard examples.

<table>
<thead>
<tr>
<th>Search Term</th>
<th>Matches</th>
</tr>
</thead>
</table>
| add*        | • The word add  
|             | • Words beginning with add, such as address |
| country c*  | Phrases such as country code or country club |
| exception \\* | The phrase exception * |

FAQs for Global Search

How can I select the categories to search on in the global search?
If personalization is available for the global search (based on setup):

1. Click in the search field.
2. Click the Personalize icon in the autosuggest.
3. In the Search Categories tab, select the categories to search on.
4. Click OK.

How can I select the groups to include in the autosuggest for the global search?
If personalization is available for the global search (based on setup):

1. Click in the search field.
2. Click the Personalize icon in the autosuggest.
3. In the Autosuggest Groups tab, select what you want to see in the autosuggest, and set the order that the groups appear in.
4. Click OK.

Why isn't the global search providing the results that I expect?
Results are based on indexes that are refreshed on a regular basis. Until the next refresh, you might not find recently created records, or attribute values might be outdated.

The business object you're looking for might not be included in the search.

- Personalize the global search (if enabled) and make sure the search category is selected.
- If you don't see a corresponding search category to select, then the business object isn't set up for the global search. Instead, use the search in the work area for that object, especially if you want to see the latest information in the search results.

If you ran a saved search, you're likely to get results that are different from when you created the saved search. The results themselves aren't saved, so records could have been added, edited, or deleted in the meantime.

Finally, make sure that you're correctly using symbols (for example wildcards) in search terms.
How can I create a saved search for the global search?
To save search terms and filters for later use in the *global search* (if available based on setup):

1. Run the search with the search terms that you want to save.
2. In the search results, click the **Show Filters** button if the filters are hidden.
3. Set any filters you want to save.
4. Click the **Save** button.
5. Name your saved search.
6. Close the Edit Saved Searches dialog box.

How can I change the criteria in saved searches for the global search?
In the *global search*:

1. Run the existing saved search.
2. In the search results, click the **Show Filters** button if the filters are hidden.
3. Update keywords or filters.
4. Click the **Save** button.
5. Leave the name as is to overwrite the existing saved search.
6. Close the Edit Saved Searches dialog box.

How can I rename or delete saved searches for the global search?
In the search results for *global search*:

1. Click the **Show Filters** button if the filters are hidden.
2. Click the **Save** button.
3. Select your saved search.
4. Rename the search or click **Delete**.
5. Close the Edit Saved Searches dialog box.

**Page-Level Search**

**Examples of Using Wildcards and Quotation Marks for Searches on the Page**

The following scenarios provide examples of using wildcards and quotation marks in search fields. Actual search results may vary, depending on factors such as how the search is set up or what data is available. These examples apply only to searches on the page, not in the *global header*.

**Note:** In most cases, the search field isn't case sensitive.

**Using Quotation Marks**

In searches with a single field for search terms, enter multiple words with quotation marks to get records that have the exact phrase. For example, if you search for *"currency code"*, then only records with the exact phrase *currency code* are included in the search results.
Using Wildcards

Use the percent (%) wildcard to get records that replace the wildcard with zero or more characters. Use the underscore (_ ) to replace the wildcard with exactly one character.

- Enter % or _ at the beginning (only in search fields that are conditionally required or not required), middle, or end of a word.

  | Caution: Using a wildcard at the beginning of a word can affect performance.

- You can use the wildcard more than once in one word.
- If the search criterion has an operator, you must select Starts with or Contains for the wildcard to work.
- To include % or _ in your search results, precede the symbol with a backslash (\) when you enter the search term. The symbol won’t act as a wildcard, but as any other character in your search term.

  If you’re using an operator other than Starts with or Contains, then you don’t need to precede % or _ with \, for the same effect.

This table shows some wildcard examples.

<table>
<thead>
<tr>
<th>Search Term</th>
<th>Matches</th>
</tr>
</thead>
</table>
| add%        | • The word add  
              • Words beginning with add, such as address |
| exp_nse     | Words such as expense or exppanse |
| e_p%        | Words such as especially or experience |
| amount \%   | The phrase amount % |

In some cases, the _ wildcard might not match spaces or symbols that separate words. For example, currency_code might not match currency code or currency/code.

Searches with Multiple Criteria

Save Searches with Multiple Criteria

On many pages, you can run a search with multiple search criteria to find specific business objects. Some of these searches have a Saved Search list, as well as a Save button after the search criteria. A saved search captures search criteria and other settings so that you can easily run the same search again later. Aside from using any predefined saved searches, you can create and edit them for your own use. If you have the appropriate roles, you can also create and edit saved searches for other users using Page Composer.
The following figure shows an example of a search with multiple search criteria fields and a Save button. For each field, you can select an operator and enter search terms. You can also select from the Saved Search list to use an existing saved search.

Create Saved Searches
Follow these steps:
1. Go to a search that has a Save button.
2. Optionally add or reorder fields, if available.
3. Enter your search criteria values, and, click the Save button.
4. Name your saved search and define its settings:
   - Set as Default: The saved search is automatically selected whenever you open this page.
   - Run Automatically (if available): The saved search runs on this page as soon as you select it from the list of saved searches.
     - If you select both options, then the saved search automatically runs whenever you open this page.
5. Close the dialog box.

Your saved search can be limited to the current page, or in some cases available in other searches for the same object.

Change the Search Criteria in Saved Searches
Follow these steps:
1. Select the saved search if it's not selected already.
2. Set your search criteria, including any additional fields.
3. Click the Save button.
4. If the saved search is one that you created, save without changing the name.
   - If it's predefined, then you can't overwrite it, so you create a new saved search with a unique name.

Change Settings or Rename and Delete Saved Searches
Follow these steps:
1. Go to a search that has a Save button.
2. Select Personalize from the Saved Search list.
3. In the Personalize Saved Searches dialog box, select a saved search.
4. Change any of the settings, where available.
   - Set as Default: The saved search is automatically selected whenever you open this page.
   - Run Automatically: The saved search runs on this page as soon as you select it from the list of saved searches.
Show in Search List: The saved search is available for you to select and run on this page.
- You can still find hidden saved searches in the Personalize Saved Searches dialog box.
- You can't change this setting if the saved search is currently selected on your page.

**Note:** Some settings can't be changed for predefined saved searches. What you do change applies only to you, unless you're editing the saved search within Page Composer.

5. If you selected a saved search that you created, then you can rename or delete it. You can't do so for predefined saved searches.
6. Save your changes and close the dialog box.

**Related Topics**
- Create Watchlist Items

**What gets saved when I create a saved search for searches with multiple criteria?**
The saved search includes the:
- Visible search fields
- Operator and value for each field
- Search mode, either basic or advanced
- *Query By Example* filters, in some cases

You don't save the current set of search results or the search result sort order.

**Keyword Searches with Filters**

**Use Filters with Keyword Searches**
One type of search you might find on the page is a keyword search with filters. The single search field takes your search terms and matches against one or more attributes of a business object. After you run the search, you can use filters to narrow down results.

The following figure shows an example of a search with a single field for search terms, as well as a link to show or hide filters.

**Running Searches and Applying Filters**
Follow these steps:

1. In the search field, enter search terms and click Search, or select an item from the autosuggest.
2. Click the Show Filters link if filters are currently hidden.
3. Optionally organize filters as follows, depending on what's available to you:
   - Use the Add or Reorder buttons.
   **Note:** Avoid adding a filter that's already displayed, unless you're sure that your filter values can work together to produce search results.
Click the **Personalize** icon to show, hide, or reorder filters, and click **OK**.

4. Apply filters as follows, depending on which type of filters is available:
   - Set filter values, and click the **Search** button.
   - Select a filter or set a filter value to automatically refresh results accordingly, and use additional filters to narrow down results further.

### Save Keyword Searches with Filters

One type of search you might find on the page is a keyword search with filters. Some of these searches have predefined saved searches, and you can also create and edit saved searches for your own use. A saved search captures entered search terms, filters, and other settings so that you can easily run the same search again later. If you have the appropriate roles, you can also create and edit saved searches for other users using Page Composer.

### Create and Edit Saved Searches

Follow these steps:

1. Enter search terms in the search field, and click **Search**, or select a saved search in the autosuggest.
2. Click the **Show Filters** link if filters are currently hidden.
3. Optionally organize filters as follows, depending on what's available to you:
   - Use the **Add** or **Reorder** buttons.
   - Click the **Personalize** icon to show, hide, or reorder filters, and click **OK**.
4. Set filter values or select filters, and click the **Save** button.
5. Name your saved search.
   - To create a saved search, enter a new, unique name.
   - To update an existing saved search that you created, save with the original name.

You can't overwrite predefined saved searches by using their names, but you can create a copy with a unique name.

6. Click **Set as Default** if you want the saved search to be automatically selected whenever you open this page.
7. Click **OK**.

Your saved search can be limited to the current page, or in some cases available in other searches for the same object.

### Change Settings or Rename and Delete Saved Searches

Follow these steps:

1. Click the **Show Filters** link if filters are currently hidden.
2. Select **Manage** from the **Saved Search** list.
3. Define settings for any saved search, predefined or user-defined, in the Manage Saved Searches dialog box:
   - **Default**: The saved search is automatically selected whenever you open this page.
   - **Show in Saved Search List**: The saved search is available for you to select and run on this page. You can still find hidden saved searches in the Manage Saved Searches dialog box.

   **Note**: Changes you make to predefined saved searches apply only to you, unless you're editing the saved search within Page Composer.

4. The **Active** setting identifies the saved search that's currently selected on the page. You can designate a different active saved search to have that saved search automatically selected as soon as you click **OK** in this dialog box.
5. For user-defined saved searches only, you can also rename or delete the saved search.
6. Click OK.
3 Watchlist

Overview of Watchlist

Use the Watchlist to track important business objects and open the pages, where you work on specific items. In the Watchlist, you can see how many items you have, and they're arranged in specific categories. For example, in the Expenses category, one Watchlist item is the **Reports awaiting submission** link. You can click the link to open the Expenses work area, and edit and submit the expense reports. To open your Watchlist, you can click the **Watchlist** icon in the global header.

**Note:** The **Watchlist** icon isn't available for certain product families.

Aside from using predefined Watchlist items, you can create your own items, based on saved searches. You can use the Watchlist page in the Set Preferences work area (**Navigator > Tools > Set Preferences**) to determine which categories and items to show or hide in your Watchlist.

**Related Topics**
- Show or Hide Watchlist Items
- Why are some items not displayed in my Watchlist
- Why can't I see some icons in the global header

Create Watchlist Items

Some saved searches are available for you to use as Watchlist items. Open a page that has saved searches and the **Manage Watchlist** button enabled. All saved searches from this page that you designate as Watchlist items would appear within one predefined Watchlist category.

Use Saved Searches as Watchlist Items

Follow these steps:

1. Create a saved search or decide which existing one to use as a Watchlist item.
2. Click **Manage Watchlist**.
3. Select the saved search you just created or any other that you want to use as a Watchlist item.

Remove Saved Searches from the Watchlist

To remove a Watchlist item based on a saved search, deselect it in the Manage Watchlist dialog box.

If you deleted the saved search first, then also deselect it from the Manage Watchlist dialog box. Otherwise, it remains in the Manage Watchlist dialog box and your Watchlist until the next refresh.

**Related Topics**
- Show or Hide Watchlist Items
- Why are some items not displayed in my Watchlist
FAQs for Watchlist

How can I rename Watchlist items?
If the item is your saved search, then rename the saved search itself. The Watchlist item name gets updated the next time that the Watchlist refreshes.
You can't rename predefined Watchlist items yourself. You can ask your administrator to do so, but the changes apply to all users.

Related Topics
- Save Searches with Multiple Criteria

Why is the count different between a Watchlist item and the page that the item link takes me to?
Watchlist item counts are refreshed periodically. Relevant records could have been created, edited, or deleted since the last refresh.
4 Notifications and Approval Workflows

Overview of Notifications and Approval Workflows

Workflow involves passing a task from one user to another, usually for approvals. You get in-app and email notifications, for example, when a workflow task is assigned to you for approval. After all assignees approve the workflow task, whatever got approved takes effect. Some tasks are just for your information (FYI), and assignees don’t need to do anything. Also, you might get notifications for things that are not part of a workflow.

Where You Get Notifications

Whether for workflow or not, here are the ways you can get notifications:

- E-mail notifications
- Notifications list in the global header
- Things to Finish section on your home page

Where You Find Workflow Tasks

You can open workflow tasks from notifications, or use your worklist to find all the tasks relevant to you. So other than notifications, here’s where you can find your tasks:

- Worklist: Notifications and Approvals work area (Navigator > Tools > Worklist)
- Worklist: Notifications and Approvals region on My Dashboard, if your administrator has added the region to the dashboard

Workflow Examples

Let’s take a look at examples of how you might interact with workflow tasks:

- Say you submit a transaction for approval, which creates a workflow task that gets routed to your approvers. An approver sends the task back to you for more information about your transaction, so you provide the requested information and send the task back. When the transaction is ultimately approved or rejected, you simply get a notification that requires no action from you.
- If you’re a manager and your employee submits a transaction that requires approval up the management chain, you would approve or reject the transaction. Other options might be available. For example, you can delegate the task so that someone else does the approval for you.

Actions and Statuses for Workflow Tasks

The status, or state, of a workflow task tells you where it’s at in the approval process. When you’re assigned to a task, what you can do with it depends on many factors, including what the task is and its current state.
### Statuses

This table describes some possible statuses, or states, for workflow tasks.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned</td>
<td>Task is assigned to you and awaiting your action.</td>
</tr>
<tr>
<td>Completed</td>
<td>Final user in the workflow has addressed the task.</td>
</tr>
<tr>
<td>Errored</td>
<td>Task is in error and can’t be recovered.</td>
</tr>
<tr>
<td>Expired</td>
<td>Current assignee hasn’t addressed the task within any defined renewal period.</td>
</tr>
<tr>
<td>Information Requested</td>
<td>Assignee requests more information from any user.</td>
</tr>
<tr>
<td>Suspended</td>
<td>Task is put on hold by the task creator and not assigned to anyone to address.</td>
</tr>
<tr>
<td>Withdrawn</td>
<td>Task creator removes task from the workflow.</td>
</tr>
</tbody>
</table>

### Actions

This table describes some possible actions you can take on workflow tasks.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ad Hoc Route</td>
<td>Add approvers to the task.</td>
</tr>
<tr>
<td>Approve</td>
<td>Approve the task, and the task completes or moves on to the next approver.</td>
</tr>
<tr>
<td>Claim</td>
<td>Assign the task to yourself so that you can act on it, if the task is currently assigned to a set of users. For example, a defined group of approvers or everyone who has a certain role.</td>
</tr>
<tr>
<td>Create Subtask</td>
<td>Create a child task to be completed as part of the original task.</td>
</tr>
<tr>
<td>Delegate</td>
<td>Pass the task to someone else to take action for you, but the task is still assigned to you. Choose the Users option and select a specific user, not the Groups option for selecting an LDAP group.</td>
</tr>
<tr>
<td>Dismiss</td>
<td>Close the task and acknowledge that you received it. You don’t need to take action because the notification is only for your information.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Escalate</td>
<td>Reassign the task to your direct manager.</td>
</tr>
<tr>
<td>Push Back</td>
<td>Reassign the task to the previous approver.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Reassign the task to someone you select. Choose the Users option and select a specific user, not the Groups option for selecting an LDAP group.</td>
</tr>
<tr>
<td>Reject</td>
<td>Reject the task and send it back to its creator in a final state.</td>
</tr>
<tr>
<td>Release</td>
<td>Make the task that you claimed available for someone else to claim.</td>
</tr>
<tr>
<td>Renew</td>
<td>Give yourself more time (seven days is the default) to act on the task, if the task is about to expire.</td>
</tr>
<tr>
<td>Request Information</td>
<td>Ask the task creator or any of the previous approvers for more information.</td>
</tr>
<tr>
<td>Resume</td>
<td>Revive a suspended task and continue working on it.</td>
</tr>
<tr>
<td>Skip Current Assignment</td>
<td>Reassign the task to the next approver (available only if you have a job role with either BPM Workflow All Domains Administrator Role or BPM Workflow System Admin Role assigned).</td>
</tr>
<tr>
<td>Submit Information</td>
<td>Send the information that was requested of you regarding the task.</td>
</tr>
<tr>
<td>Suspend</td>
<td>Put the task on hold until it's resumed. In the meantime, no one is assigned to act on it.</td>
</tr>
<tr>
<td>Withdraw</td>
<td>Remove the task from the workflow (available only if you created the task).</td>
</tr>
</tbody>
</table>

**View and Act On Notifications**

Notifications alert you that something requires your attention or action. Click the **Notifications** icon in the **global header** to open your notifications list. The number on the icon tells you how many pending notifications you have, if any. Pending means that you haven’t acted on the notification or dismissed it yet.

Most notifications are for *workflow* tasks, but not all. So it’s possible that what you see in the list isn’t the same as what you see assigned to you in the Worklist: Notifications and Approvals work area. Also, for one task you see in that work area, you might get more than one notification. For example, one notification that someone requests information from you about the task, and later another notification that the task is approved.
Here's an example of the notifications list in the global header. The Notifications icon says there are 25 pending notifications. The first three are new ones you have never seen before and require some action on your end. The third one you can approve or reject without even opening the notification. The next two are just FYI.

On your home page, you can also find notifications in the Things to Finish section, which looks like this.

The first card in the Things to Finish section has two numbers:

- **Assigned to Me**: The number of notifications assigned to you either to act on or just FYI, in this case 10. The rest of the cards in the Things to Finish section are the notifications assigned to you, the exact same as the pending notifications you see in the global header.
• **Created by Me:** The number of workflow tasks you submitted that are still pending final approval, in this case 2.

Here are some things to know about both the Things to Finish section and the notifications list in the global header:

- From either place, you can open the Notifications page. That’s where you can view and manage all your notifications in one place, not just the ones that are pending and assigned to you.
- Updates you make to workflow tasks in the global header, for example approving them, are automatically reflected in the Things to Finish section. Same goes the other way around, too. But changes you make elsewhere and changes that someone else makes aren’t reflected in either place until the **Synchronize Notifications in Global Header** process runs, for example every two hours. The scheduled process updates workflow notifications with the latest task status and removes notifications older than 30 days no matter the status. For example, you approved one task from email, and someone else in the approval group that you’re part of rejected another task from their notifications list. After synchronization, the notifications asking approval for these two tasks are removed from your list in the global header and your Things to Finish section. Because these tasks are no longer pending for you, based on the latest task status.

No matter where you see the notification, the language of the notification title might not be the same as the language that you selected when you signed in to the application. The title is always displayed in the language that was used when the notification was generated.

### How You Address Your Notifications

To view and act on notifications in the Things to Finish section, the global header, or the Notifications page:

1. Click the **Notifications** icon in the global header, or go to the Things to Finish section on the home page.
   - Here are a couple of things to know about the list that opens up in the global header:
     - The **New** icon (a blue dot) identifies any new notifications. Even if you close the list now without doing anything else, the same notifications are no longer new the next time you open the list.
     - You can search based on the text of the notification titles in the list. For example, if you search by the term **reports**, search results include all notifications with **reports** in the title, but not the ones with **report**.
   - In the Things to Finish section, you can click the **Close** icon just to remove the card. The notification is still assigned to you, so you can still find it, for example, in the global header or the Assigned to Me tab on the Notifications page.

2. Go on to the next step, or click one of these links to open the Notifications page:
   - **Show All** from the notifications list in the global header
   - A number on the first Things to Finish card to open the corresponding tab on the Notifications page, Assigned to Me or Created by Me
   - **Show More** in the Things to Finish section

3. For a notification that requires action, you have a few options:
   - Click the **Approve** or **Reject** button, where available.
   - Open the **Actions** menu and select an action, where available.
   - Click the notification title to see the details and select from all available actions. Depending on what the notification is about, some actions might not apply. For workflow tasks, you get the same task details that you do from your worklist, using the Worklist: Notifications and Approvals work area or region.
4. For a notification that doesn't require action, you also have a few options:
   o Click the **Dismiss** button to acknowledge the notification. For workflow tasks, this option is available only for FYI tasks. The FYI task itself isn't marked as acknowledged, so it's still pending to be either manually or automatically completed.
   o On the Assigned to Me tab on the Notifications page, click the **Dismiss All** button.
     - For workflow tasks, this option is available only for tasks where action is already taken and there's no more action pending with assignees. For example, the task is approved or withdrawn. This option doesn't apply to FYI workflow tasks.
     - If you still see some notifications after you click **Dismiss All**, those are notifications for FYI workflow tasks, notifications that still require action, or notifications that you have to first open up to see details before dismissing.
   o Click the notification title to open the details.
   o Just read the notification title, if the title is text-only and not a link because there aren't any details to display.

5. On the Created by Me tab on the Notifications page, you can see the workflow tasks you submitted that are pending final approval or already completed. Where available, you can take action on the pending items, for example to withdraw your request.

No matter which option you choose to address notifications that require action or not, the notification is taken off the list in the global header and is no longer assigned to you in the Things to Finish section or the Notifications page. You can still find the notification on the All tab on the Notifications page.

**Use Alternate Notifications UI**

If your administrator has selected the panel or banner home page layout, then you get an alternate UI when you click the **Notifications** icon in the global header. Also, the Things to Finish section and Notifications page aren't available.

Let's take a look at the alternate notifications list. In this example, you have two pending notifications, the first one you have never seen before. You can approve or reject both notifications without even opening them.

Here's how you use the alternate notifications list in the global header:

1. Click the **Notifications** icon in the global header.
In the list that opens up, the New icon (a blue dot) identifies any new notifications. Even if you close the list now without doing anything else, the same notifications are no longer new the next time you open the list.

2. Take any of these steps to get another view of notifications:
   - Click the drop-down button to switch between pending notifications and all notifications.
   - Search based on the text of the notification titles in the list. For example, if you search by the term reports, search results include all notifications with reports in the title, but not the ones with report.
   - Click the More Details button to view and manage workflow tasks in your worklist.

3. For a notification requiring action, you have a few options:
   - Click the Approve or Reject link, where available.
   - Open the Actions menu and select an action, where available.
   - Click the notification title to see the details and select from all possible actions you can take. For workflow tasks, you get the same task details that you do from your worklist, using the Worklist: Notifications and Approvals work area or region.

The notification goes off the pending list now that you have acted on it.

4. For a notification that doesn’t require action, you also have a few options:
   - Click the Clear icon that appears when you hover over the notification, to dismiss the notification.
   - Click the notification title to open the details.
   - Just read the notification title, if the title is text-only and not a link because there aren’t any details to display.

In all cases, the notification is considered read and taken off the pending list. To keep a notification as pending, you can click the Undo link that temporarily shows up near the notification title after you click the title or Clear icon.

Related Topics
- Synchronize Notifications in the Global Header and Home Page with Workflow Tasks

Use Your Worklist to Manage Workflow Tasks

You can use the notifications list in the global header or the Things to Finish section on the home page to act on recent notifications for workflow tasks. To manage all your workflow tasks, use your worklist instead. For example, you can keep track of tasks that you created, or browse for tasks by status. To get to your worklist, open the Worklist: Notifications and Approvals work area.

You can also find your worklist on My Dashboard, if your administrator has added the Worklist: Notifications and Approvals region to that dashboard. There, you get a quick view of all the tasks that are currently assigned to you.
Use the Worklist: Notifications and Approvals Work Area

Let’s take a look at some parts of this work area.

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>UI Element</th>
<th>What You Use It For</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current Selected View menu</td>
<td>To see a certain set of tasks, for example the tasks you created.</td>
</tr>
<tr>
<td>2</td>
<td>Actions menu</td>
<td>To perform an action on the tasks you select in the table.</td>
</tr>
<tr>
<td>3</td>
<td>Title column</td>
<td>To open the task details by clicking the task title.</td>
</tr>
<tr>
<td>4</td>
<td>Status list</td>
<td>To filter the tasks you see in the table based on the task status you select.</td>
</tr>
</tbody>
</table>

Here’s how you use this work area to manage workflow tasks:

1. Click **Navigator > Tools > Worklist**.
2. To see only the tasks that you created, click the **Current Selected View** menu and select **Initiated Tasks**. Or, just leave the default My Tasks view to see tasks assigned to you now or in the past, or select any other available view.
3. Use the **Status** list to see just the tasks with the status you select.

**Tip:** If the table is empty when you first open the work area, try selecting **Any** from the **Status** list. You might not have any tasks with the Assigned status, which is the default for this filter.

4. To act on a task without viewing the task details, select the row and use the **Actions** menu on the table toolbar. Or, click the task title to see the task details.
5. In the task details, you might also be able to do some things that don’t affect the routing or status of the task, including adding comments, adding attachments, and viewing the approval history. If you don’t see sections for these things, use the equivalent options from the **Actions** menu in the task details.
   - **Add Comments:** Enter comments that anyone with access to the task can see.
- Add Attachment: Attach files that anyone with access to the task can see.

- View Approvals: See the approval history for the task. For example, for a task that you created, you can see who already acted on your request, whose approval you still need, and what the status is with each assignee.

If you see both a table and a flowchart, you're looking at two views of the same history, with past assignees listed in sequential order. To add more assignees to the task:

  i. In the History table, select a future assignee who hasn't yet acted on the task.

  ii. On the table toolbar, click the Add icon to insert an assignee before or after the one you selected.

If you're the last assignee, you can't add assignees using this Add icon. So you might try instead the Ad Hoc Route or Reassign options from the Actions menu in the task details, if available.

6. In the task details, use the buttons or Actions menu for tasks that you need to act on. Here are some possible options in the Actions menu:

  o Request Information: Select the person you want information from, and enter what you're asking for in the Comments field. Indicate if the task should come directly back to you or go through the usual workflow process, after the person you selected has provided the information you asked for.

  o Reassign: Select whom to pass the task on to. Indicate if you're reassigning the task or just delegating it for someone to act on your behalf.

7. For more things you can do with your worklist, click View on the table toolbar in the Worklist: Notifications and Approvals work area. Select Servers and click the Worklist link

Use the Worklist: Notifications and Approvals Region

You get this region only if your administrator has added it to My Dashboard.

1. Click Navigator > Others > My Dashboard.

2. Use the Worklist: Notifications and Approvals region the same way you would use the Worklist: Notifications and Approvals work area, except here you can see only tasks with the Assigned status.
Define Vacation Rule for Workflow Tasks Assigned to Me

Work goes on even when you’re not working! To control what happens to workflow tasks that are assigned to you while you’re out of office, define a vacation rule. You can reassign your tasks to others, or delegate it to them to act on your behalf.

Enable and Define the Rule

Here's what you do:

1. In the global header, click the Notifications icon.
2. Click Show All.
3. On the Notifications page, click the Worklist button.
4. In the new browser window, click your user name and select Preferences.
5. On the My Rules tab, select the Vacation Period rule if it isn’t already displayed.
6. On the Vacation Period page, select the Enable vacation period check box, and enter the start and end date for your time out of office.
7. Select to reassign or delegate your tasks, and provide an assignee.
8. Save your work.
FAQs for Notifications and Approvals

Why are workflow notifications that I acted on still in the global header and home page?

The notifications list in the **global header** and the Things to Finish section on the home page doesn't immediately reflect changes to the workflow task status if you took action elsewhere. For example, if you approved the task through email or the Worklist: Notifications and Approvals work area. You still see the notification in the global header and, home page until after the next scheduled run of the **Synchronize Notifications in Global Header** process. The same goes for the Notifications page that you can open from the notifications list in the global header or from the Things to Finish section.

**Related Topics**

- Synchronize Notifications in the Global Header and Home Page with Workflow Tasks

Why can't I see a workflow notification in the global header and home page when I can see it elsewhere?

Let's say you get an email notification but don't see it in the notifications list in the global header and the Things to Finish section on the home page. Most likely your administrator has enabled only email notifications, not in-app notifications. In which case, you can still find the corresponding workflow task in the Worklist: Notifications and Approvals work area.

Or, say you don't get a notification in email, the global header, and home page, but can see the task in the Worklist: Notifications and Approvals work area. It's possible your administrator disabled all workflow notifications. Or, if the user ID you use to sign in with has a space in it, that would cause issues with sending notifications. Ask your security administrator to update your user account and remove any spaces in your user ID.

It's also possible that you did see the notification in the global header, the home page, or Notifications page, but you can't find it there anymore even though you didn't address it yet. And, you might still see the task in the Worklist: Notifications and Approvals work area. Most likely that means your notification is older than 30 days and was removed. Or, maybe the notification is for a task that's assigned to an approval group that you're part of, and someone else acted on the task so it's no longer pending for you.

How do I remove notifications from the global header and home page?

Submit the **Synchronize Notifications in Global Header** process to run on a schedule, for example every two hours. The process removes notifications older than 30 days from the notifications list in the global header, the Things to Finish section on the home page, and the Notifications page that you can open from either of the first two places. At any time, you can also manually remove notifications older than 30 days. Just click **Notifications** in the **global header** and run a search.
If a notification is for a workflow task, it's still removed no matter what the task status is. You may still be able to find the task in the Worklist: Approvals and Notifications work area.

Related Topics
- Synchronize Notifications in the Global Header and Home Page with Workflow Tasks

Monitor and Troubleshoot Transactions

Manage Workflow Transactions

After workflow tasks are created, it's helpful to keep track of them and jump in when you need to, especially when something goes wrong. If you have the appropriate roles, you can monitor and troubleshoot workflow tasks for others and for yourself. Use the Transaction Manager: Transactions page in the Transaction Console work area to manage transactions. A transaction is a business process that involves a workflow task.

Here are some of the things you can do:
- Track transaction statuses and download spreadsheets with information about transactions.
- Download and review diagnostic logs for transactions with errors. For example, you can see the conditions in the approval rules that might have caused the error.
- Depending on what's going on with the transaction and what roles you have, you might be able to, for example, reassign or recover the transaction.

Find Transactions

Follow these steps:

1. Click Navigator > Tools > Transaction Console.
2. If you see tabs, make sure you're on the Transaction Summary tab.
3. On the Transaction Manager: Transactions page, check the Last Refresh time stamp after the page title to see when the transaction statuses were last updated. Click the Refresh icon if needed. You can refresh any time as long as someone else didn't already start a refresh.
   - Also, the Refresh Transaction Administrator Console Transaction Status scheduled process automatically runs every hour to refresh the statuses. If you find that's not enough, you can submit the process to run on a more frequent schedule. Your process would run instead of the automatic hourly one.
   - If you open the details for a specific transaction (step 5), its status also refreshes and you see the latest on the details page.
4. View the transactions with a status that matches the default Status filter, for example Failed. You can remove this filter to get results for all statuses. Or, use the search and filters to apply your own criteria, for example, to find transactions that are priority 1 or submitted by a specific person.
   - You can use the search to find results based on keywords in the Name or Process Name column, or specifically use the Name or Process Name filters. Name is the person or object the workflow task applies to, and the process reflects the type of workflow task.
   - You can personalize filters to add or hide filters, and create saved searches for future use.
5. Select and act on the transactions right there from the results table, or click the transaction in the Name column to see details, such as diagnostic information for failed transactions, and go from there.
Act On Transactions Without Opening Details

Here's what you do:

1. Select one or more transactions from the results table.
2. Optionally use the Priority menu to set an issue priority, so that you can later filter on the priority to find these transactions.
3. Open the Actions menu and select an action. If you selected more than one transaction, you see only the actions that can apply to all of them.

Use Transaction Details

What you can see and do in the transaction details depends on the transaction status and what roles you have. For example, for transactions that are in progress or completed, you might see the approval history, which shows who already approved and who the current assignee is, if any.

For failed transactions, you can get information about the issues and, if you’re an administrator, usually take some action:

1. Select an issue from the Issues list, if the transaction has more than one issue.
2. Review the information in the Instructions and Details sections, including any description and resolution for the issue, as well as the related workflow task and approval rule.
3. Click the Download link to get the diagnostic log.
4. Use the Issue Priority list to set an issue priority, if you want to later filter on the priority to find this transaction.
5. From the Assigned To list, select the person who should fix the issue, for tracking and filtering purposes.
6. Add comments, for example to track what you’re doing to address the issue, or note down any service request IDs. You and others can see these comments only in the Transaction Console, not with the workflow task in the worklist.
7. If you can, take action to address the issue. Here are some examples of how you might go about it:
   - Open the Actions menu and select an action to manage the transaction.
   - Follow up with the person you assigned the issue to or your help desk. Give them the diagnostic log and other information from the transaction details.
   - Reconfigure the approval rule that the transaction is based on, and have the workflow task resubmitted.
8. Select another issue from the Issues list, if any, and go through the same process.
9. Click Save and Close.

Download a Spreadsheet of Transactions

This is all you need to do:

1. In the results table, select the transactions you want to include in the spreadsheet. To get all transactions, either select all of them or none at all.
2. On the Actions menu, click Download.

Related Topics

- Use Filters with Keyword Searches
- Save Keyword Searches with Filters
- Submit Scheduled Processes and Process Sets
Statutes for Filtering Transactions

Use the Transaction Manager: Transactions page in the Transaction Console work area to track the status of transactions. For example, you can filter the transactions by status to see just the transactions that are in progress or stuck. These statuses aren't the actual workflow task statuses that you see in the worklist or in notifications.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Recovery</td>
<td>The transaction ran into some issues, but the application is trying to fix them without any action on your end.</td>
</tr>
<tr>
<td>Completed</td>
<td>All approvals are done and the transaction successfully went through all processes.</td>
</tr>
<tr>
<td>Draft</td>
<td>The transaction is saved but not submitted yet. This status doesn't apply to all product families.</td>
</tr>
<tr>
<td>Failed</td>
<td>The transaction has one or more errors, for example, due to a network or database outage, or an issue in the approval rules setup.</td>
</tr>
<tr>
<td>In Progress</td>
<td>At least one approval is still pending for the transaction before it's all done.</td>
</tr>
<tr>
<td>Stuck</td>
<td>The transaction was submitted, but ran into issues so the workflow task doesn't exist yet.</td>
</tr>
<tr>
<td>Submitted</td>
<td>The transaction was just created and hasn't moved on yet to another status. This status doesn't apply to all product families.</td>
</tr>
</tbody>
</table>

Actions for Managing Transactions

Use the Transaction Manager: Transactions page in the Transaction Console work area to manage and troubleshoot transactions. For example, you can withdraw a transaction even if you're not the one who submitted it. What you can do depends on the transaction status and the roles you have. Some actions, such as approve and reassign, are the same as the ones you can take on the workflow tasks from the worklist or from notifications.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Comment</td>
<td>Add your notes for the transaction, for example to track what you’re doing to address the issue, or to jot down any service request IDs. You and others can see these comments only in the Transaction Console.</td>
</tr>
<tr>
<td>Alert Initiator on Error</td>
<td>Notify the submitter if the transaction ends up in error.</td>
</tr>
</tbody>
</table>
### Action Description

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>Approve the transaction if the workflow task is currently assigned to you to approve or reject.</td>
</tr>
<tr>
<td>Download</td>
<td>Get a spreadsheet with information about the selected transactions.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Reassign the workflow task to an approver, the submitter, or someone else.</td>
</tr>
<tr>
<td>Recover</td>
<td>Restart the process after the transaction stopped due to errors. After you address the issue, use this action to get the application to pick up where the process last left off and retry whatever had ended up in error.</td>
</tr>
<tr>
<td>Reject</td>
<td>Reject the transaction if the workflow task is currently assigned to you to approve or reject.</td>
</tr>
<tr>
<td>Terminate Process</td>
<td>Completely end the transaction so that no one can see or act on the workflow task again.</td>
</tr>
<tr>
<td>Withdraw</td>
<td>Remove the workflow task from the workflow. You can ask the submitter to submit again, for example, after an issue is resolved.</td>
</tr>
</tbody>
</table>

### How You Can Regularly Reassign Pending Approvals for Workers That Become Inactive

A manager assignment can become inactive due to the end of an assignment or work term, termination, or global transfer. If the manager has any pending approval notifications, you must reassign them.

**Run this process:** Run Reassign Pending Approvals for Terminations and Correct Invalid Supervisor Assignments Process in the Scheduled Processes work area. You can set a schedule to run it at least once a day. You can run it more frequently if you want things updated faster.

Here's what the process does:

- It reassigns the direct reports of a terminated manager to that person’s line manager and also assigns any pending notifications to the line manager. Only actionable notifications will be reassigned.
- It reassigns pending approval notifications based on the number of days you specify using the Past Period in Days Considered for Reassigning Pending Approvals parameter.

**Related Topics**

- Submit Scheduled Processes and Process Sets
5 Tables

How You Use Tables

You can find tables on many pages. Some tables are simple, while others give you several options to view and manage the data. Many of these options are described here, and they may or may not be available on the particular table you’re using. You can find most of the options in the table toolbar, which usually has menus such as Actions, View, or Format.

Select Data

To select a row or column:

- **Row:** Click anywhere within the row. Or, hover over the small cell beside first column, and click when your cursor becomes an arrow.
- **Column:** Hover over the column heading and click when your cursor becomes an arrow. In tables that allow multiselect, you can use the Shift or Control key to select multiple rows at once.

**Note:** Some items in the table menus or toolbar are disabled until you select a row or column. For example, only after selecting a row, you can then select **About This Record** from the **View** menu, to see who created and last updated the record, and when. The **Creation Date** field shows the date and time when you first start creating a record. The **Last Update Date** field shows the date and time when the record is saved. So, suppose you start creating a record, enter data, and then click **Save** after 35 seconds. The time displayed for **Creation Date** and **Last Update Date** will have a difference of 35 seconds. If you make any subsequent updates to the record, your last update date will change.

View Data

To help you view the data in the table, you can:

- Use filters in the toolbar or **Query By Example** to narrow down the data. Query By Example is the row of fields that precedes the column headings.
- Click **Refresh** in the toolbar, or select Refresh from the Actions menu. You reload the table with the latest available data.
- Click **Detach** in the toolbar, or select **Detach** from the View menu. You can see more of the table in the detached view.
- Select a column and click **Wrap** in the toolbar, or select **Wrap** from the View menu. You can see all the text in each cell within the column.
- Click **Export to Excel** in the toolbar, or select **Export to Excel** from the Actions menu. You get a Microsoft Excel file with the data in the table.

Sort Data

To sort the data in the table:

- Hover over the column heading of the column you want to sort by, and click the **Sort Ascending** or **Sort Descending** icon.
- Select **Sort** from the View menu.
Edit Data
To edit data in a table, you can:

- Select a row and click **Edit** in the toolbar to open a dialog box or another page.
- Click a link in the row to open a dialog box or another page.
- Click a row to make that row editable within the table.

Manage Columns
You can determine which columns to see and how they appear using the **Manage Columns** option from the View menu. But the **Manage Columns** option isn't available for tables with flexfields. To check whether a table on a page contains flexfields, click your user image or name in the global header, and on the Settings and Actions menu, select **Highlight Flexfields**. If you don't have administrative privileges, you may not find the **Highlight Flexfields** option.

- **Hide or show**: Select **Columns** from the View menu.
- **Resize**: Hover between column headings and move the divider. Or, select the column, and then select **Resize Columns** from the Format menu.
- **Reorder**:
  - To move a column, click the column heading and, when your cursor becomes two double-pointed arrows, move the column to a new position.
  - To reorder multiple columns, select **Reorder Columns** from the View menu.
- **Freeze**: Select the column that you want to freeze, and then either click **Freeze** in the toolbar or select **Freeze** from the View menu.

Related Topics
- Overview of Flexfields
- How can I locate flexfields on a page

Query By Example

Use Query By Example
Query By Example is the row of fields that precedes the table column headers, used for filtering the data in the table.

Applying the Query By Example Filter
Follow these steps:

1. Click **Query By Example** on the table toolbar if the row of fields isn't displayed.
2. Enter filter values in any or all of the Query By Example fields.
3. Press **Enter**.

The table now shows only the records that meet the criteria you entered in all Query By Example fields.
Refreshing the Filtered Results

Do any of the following:

- Press Enter again with your cursor in any of the Query By Example fields.
- Click Search or Refresh on the toolbar, if available.
- Select Refresh from the View menu, if available.

**Note:** The filter applies even if the Query By Example fields are hidden.

Removing the Query By Example Filter

Click the Clear All icon at the beginning of the Query By Example row, if available.

If not, then:

1. Delete what you entered in each Query By Example field.
2. Refresh the table.

To clear not just Query By Example but any other table filters:

1. Select Clear from the View menu or click Clear on the table toolbar, if available.
2. Refresh the table.

Operators and Wildcards for Query By Example

You can use operators and wildcards in Query By Example fields. Operators and wildcards work in alphanumeric fields only, not date fields.

**Operators**

This table describes the operators that you can enter in Query By Example fields.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None (you enter only a value)</td>
<td>• Character field: Starts with</td>
</tr>
<tr>
<td></td>
<td>• Number or date field: Equals</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Great than or equal to</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>and</td>
<td>And</td>
</tr>
</tbody>
</table>
### Operator

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>or</td>
<td>Or</td>
</tr>
</tbody>
</table>

**Note:** You can use this operator only in conjunction with other operators, for example: >0 and <=1000.

For the >, <, >=, and <= operators:

- Results are based on alphanumeric sort, in alphanumeric fields. For example, if you enter >=ABC, then ABC, ABD, ABCA, ACB, and BAC are matches, but not AB5 or AB.
- A space is considered part of the filter value. For example, if you enter >= ABC, then ABC and ABD are matches only if they're preceded with a space.

### Wildcards

This table describes the Query By Example wildcards that you can use at the beginning, middle, or end of your entered value. All other symbols are ignored.

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Multiple characters</td>
<td>Entered Value: add*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Matches: The word add and words beginning with add, such as address</td>
</tr>
<tr>
<td>?</td>
<td>Single character</td>
<td>Entered Value: exp?nse</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Matches: Words such as expense or expanse</td>
</tr>
</tbody>
</table>

### Export to Excel

**What's the difference between Export to Excel and desktop integration for Excel?**

You use the **Export to Excel** button or menu option to download data from your table as a Microsoft Excel file. You can then use this file to view or analyze your data.

You use desktop integration for Excel to create or edit records in Excel workbooks, and then upload them back into the application. This comes in handy when you have to work offline or make mass updates. In most cases, you download the desktop integrated workbook from a link in a panel tab or your table.
Related Topics

- Guidelines for Using Desktop Integrated Excel Workbooks

What's included in the file I get when I export a table?

You get the rows you select in the table. If row selection is disabled or you don’t select anything, then you get all rows, including any that aren’t visible on the page.

In any case, some data might not be included if:

- Any search criteria, filters, and Query By Example values apply to the table.
- The table has any hidden columns.
- You’re working with a table that shows a certain number of rows per page or view. Try going to subsequent pages or views to export.
Excel Add-Ins

Oracle ADF Desktop Integration Add-In for Excel

Set Up Desktop Integration for Excel

You can create or edit records and upload them to the application using integrated Excel workbooks. To use these workbooks, you must install an Excel add-in.

**Note:** Every release of Oracle Applications Cloud is likely to have a new version of the Oracle ADF Desktop Integration add-in. When prompted, install the latest version of the add-in. For more information, see Add-In Upgrade Policy for ADF Desktop Integration (2242879.1) on My Oracle Support at https://support.oracle.com.

Install the Desktop Integration Add-In

To install the Oracle ADF 11g Desktop Integration Add-In for Excel, you must have the appropriate Excel and Windows version. Refer to the Excel and Windows version listed in the Supported Platforms for ADF Desktop Integration (2242428.1) on My Oracle Support at https://support.oracle.com. Also, make sure that you have the Employee (ORA_PER_EMPLOYEE_ABSTRACT) role to access the add-in installer.

1. Sign in to your computer with your account. For example, you can’t have someone else sign in as an administrator and make the installation available for everyone using your computer.
2. Close Excel.
3. Click **Navigator > Tools > Download Desktop Integration** to download the installer file.
4. Run the `adfdi-excel-addin-installer.exe` installer just like you would run any program that you install on your computer.
5. Run Excel once to complete the installation.
6. Optionally install these software from the Microsoft website.
   - Microsoft .NET Framework 4.5.2
   - Microsoft Visual Studio 2010 Tools for Office Runtime (VSTO Runtime)

   The add-in installer does check if you have these software already, and would download and install them if needed. However, if you run into issues installing them as part of installing the Excel add-in, you can manually install them first.

**Note:** You can also install the add-in for all users at a time. For more information, see How to install the ADF Desktop Integration Add-in for Excel (2681794.1) on My Oracle Support at https://support.oracle.com.

Guidelines for Using Desktop Integrated Excel Workbooks

Where available, you can download a desktop-integrated Microsoft Excel workbook and use it to create or edit records. Your edits in the workbook don’t affect the application until you upload the records back into the application.
What You Must Not Do
To ensure that you successfully upload your changes to the application, avoid doing these tasks:

- Rename text from the integrated workbook, such as the worksheet or the tab names.
- Add columns.
- Delete any part of the template, such as columns.
- Hide required columns and status columns or headers.

**Caution:** Don't close Excel using the Windows Task Manager and clicking the **End task** button because that might disable the add-in.

Conventions
Some column headers in the integrated workbook might include [..]. This means that you can double-click within any cell in the column to open a dialog box, where you can select a value to insert into that cell.

Statuses
You can use **Status Viewer** to see the status of the entire integrated worksheet and the status of any row in a worksheet. To use the status viewer, click **Status Viewer** on the Excel ribbon. You can see the status of the entire integrated worksheet by default. To see the status of a row, click any table row in a worksheet. You can use the information that appears on the **Status Viewer** to review and correct errors at the same time.

Searches
Some integrated workbooks have searches. To search within the workbook, you must first sign in to the application. When you click the **Search** button, the application prompts you to sign in if you haven't already done so.

Refreshes After Upload
If your changes aren't reflected after you upload the records back into the application, you can try out these options:

- Refresh the table
- Use a filter or search on the table to see your changes

Related Topics
- How You Use Tables

Troubleshoot Desktop Integration for Excel
If you run into any issues with the integration, use the Client Health Check tool first to find out what integration issues you might have and how to resolve them. If the health check tool doesn't resolve your issue, you can uninstall and reinstall Oracle ADF Desktop Integration add-in.

Use the Client Health Check Tool

1. Download the latest version of the health check tool from How to use ADF Desktop Integration Client Health Check Tool (2010222.1) on My Oracle Support at https://support.oracle.com. If you're unable to find this tool, ask your help desk.
2. Run **ClientHealthCheck.exe** just like you would run any other program on your computer, and review the result for each checked item.
3. Select any item that has a problem, and read the help text.
4. Click Fix Problems to fix some of the problems. Otherwise, follow the instructions in the help text.
5. If you need more assistance, click Save Report As to prepare information for your help desk.
6. Review the report and remove any sensitive information.
7. For more assistance, contact your help desk and provide your report.

For more information, see Information Center: Troubleshooting Oracle ADF Desktop Integration (2012600.2) on My Oracle Support at https://support.oracle.com.

Uninstall the Desktop Add-In

Use the Microsoft Windows Control Panel to remove the ADF Desktop Integration add-in. After removing the add-in, you can no longer use the integrated Excel workbooks on this system unless you reinstall the ADF Desktop Integration add-in.

1. Open the Control Panel and go to Programs and Features.
2. Select Oracle ADF Desktop Integration Add-In for Excel from the list of programs.
3. Click Uninstall from the toolbar at the top of the program list.
4. When prompted, click Yes to remove Oracle ADF Desktop Integration add-in.

Note: If you have installed Oracle ADF Desktop Integration add-in on multiple user profiles, you must remove it from each user profile.

Oracle Visual Builder Add-In for Excel

Use Oracle Visual Builder Add-in for Excel to integrate Microsoft Excel spreadsheets with REST services to retrieve, analyze, and edit business data from the REST service. You can download your data to an Excel spreadsheet, work with it, and upload your changes back to the REST service. After you install the add-in, a new ribbon tab (Oracle Visual Builder) appears in Microsoft Excel. You can use the buttons in this ribbon tab to configure a worksheet to integrate with a REST service and download the data to a data table that you create in the worksheet. Once you create the data table and populate it with data, you can review, modify, and create data before uploading changes to the REST service. After you integrate the Excel worksheet with the REST service, you can optionally publish the Excel workbook that contains the integrated worksheet.

Related Topics
- Using the Oracle Visual Builder Add-in for Excel
7 Attachments

How can I delete attachments?

Use the **Delete** icon button. Alternatively, you can use the **Manage Attachments** icon button to open the Attachments dialog box and delete specific attachments.

Can I view attachments in a different format?

Attachments, by default, appear in the table view. You can also view them in two other ways, list view and cards view, if the options are enabled.

To switch between the different views, click the toggle buttons on the toolbar.

How can I filter attachments?

Use the filtering options, if enabled, on the toolbar of the attachments window to display only those attachments that are specific to your search. You can filter attachments by Type, Title, Description, Category, and so on.

If you filter the attachments by Type, you get additional options to search for a specific file, folder, text, or a URL.

What happens if I update an existing attachment?

If an attachment of the same type and name is uploaded again for the record, the attachment gets stored as a new version. The previous attachment remains available, displaying the time stamp to indicate how old that version is. To view the version of an attachment for a record, click **Actions > File Revision History**.

By default, always the latest attachment appears for a particular record. However, if the option is enabled, you can pick any other version of that attachment and set it to default. Anyone viewing the attachment for that record will see the default version that you set, even if that's not the latest one.
8 Data on Application Pages

How can I print the data in the page I am on?

Click your user name or image in the global header and select Print Me, if available, from the Settings and Actions menu. You get a view of the page, which you can then print using your browser’s standard print feature. This view includes any field, table, or other UI element on the page that has data. If the page has tabs, then only the currently open tab is included.

If you want just the data in specific tables, you can also use the Export to Excel button or menu option on the table, if available. You get a Microsoft Excel file containing data from the table, which you can then print.

Related Topics
- What’s included in the file I get when I export a table

Why can't I see all the values I expect in my list of values?

Probably your list of values (LOV) has more than 500 values. By default, any LOV displays a maximum of 500 values. So, if you can’t see your LOV in the list, you can use the Search field to find specific values.

How can I locate flexfields on a page?

Open the page where you want to locate flexfields, click your user image or name in the global header, and on the Settings and Actions menu, select Highlight Flexfields. You can hover over the Basic Info icon to see details about specific flexfields. If you can’t find the Highlight Flexfields option, that’s probably because you don’t have administrative privileges.

Enter or Edit Translated Text

For a row in a table or for a field in a form, you can use the Translation Editor icon (when available) to view, edit, or enter the translated text for the supported languages. You don’t need to sign out of your current session to do this task.

1. Click the Translation Editor icon on the table toolbar or in the form.
2. On the Edit Translations dialog box, select the row of your preferred language and enter or edit the translated text in the editable fields. You can enter translation text for multiple languages.
3. Click OK.

If the translated text is in a language that’s the same as that of your current session, you can see the translation apply to the UI immediately.

Related Topics
- How can I determine which languages appear in the Translation Editor
What's the difference between Language and Source Language?

When a text value is created, the language that it’s created in is considered as the source language in the translation editor. This value is used as the default one if no translated text is available.

When a translated text is entered, the source language value is updated to the language for that translated text. For example, suppose you have a row with text value created in American English. If you use the translation editor to update that row with the value for language as Spanish, the source language for that row will be updated to Spanish. So, a quick glance at the translation editor tells you which values are translated and which aren’t. For example, if the values in the Language and Source Language fields match, that means the values are translated. While, if they don’t match, that means the values aren’t translated, and you can also tell where the default value is coming from. If the default value for a row's source language is changed, all values for the rows whose Language and Source Language fields match, will also change.
9 Scheduled Processes

Overview of Scheduled Processes

Scheduled processes do tasks that are too complex or time-consuming to do manually, for example importing data or updating many records. You can run scheduled processes on a recurring schedule and send notifications based on how the process ends. Some scheduled processes give you printable output. Those processes might have Report in their name.

Jobs and Job Sets
Each scheduled process that you run is based on a job. The job is the executable that controls what the process can do and what parameters and other options you have for the process. A job set contains multiple jobs.

You or your administrator can create job definitions for Oracle Business Intelligence Publisher reports so that people can run the reports as scheduled processes.

Process Sets
A process set is a scheduled process that's based on a job set. So, when you submit a process set, you're running more than one job.

**Note:** When you submit certain scheduled processes, the job logic causes other processes to automatically run. But in this case, you're not submitting a process set that includes those other processes.

Submission
When you submit a scheduled process, you can use its parameters to control which records are processed and how. For example, a process includes only the transactions that were edited by the person you select for a Last Updated By parameter. Some scheduled processes don't have parameters.

As part of the submission, you can also set up a schedule for the process, for example to run once a week for two months. Every time a process runs, there's a unique process ID.

Output
Some scheduled processes provide output in PDF, HTML, and other formats. For example, a process can import records and also produce output with details about those records. There are many types of output, for example a tax document or a list of transactions.

Related Topics

- Create Job Definitions to Run Reports as Scheduled Processes
Process Sets

A process set is a type of scheduled process that's based on a job set and contains at least two processes. So you can run many processes in one go, for a specific purpose. These processes run in a certain order, in serial or parallel, or by some other logic. For example, let's say we have a process set with three processes to do these three tasks:

- Validate and clean up records.
- Import the records.
- Give a report on the imported records.

What They Contain

Process sets can have any number of individual scheduled processes and even other process sets. Sometimes, a single process set has multiple process sets that are nested. For example, a process set can include three processes and two process sets, one of which contains another process set.

Submit Processes

Submit Scheduled Processes and Process Sets

Use the Scheduled Processes work area to run all the scheduled processes that you have access to, including process sets. You can also submit many processes from other work areas. Some of the processes that give you output are also reports that you can view from the Reports and Analytics work area or panel tab. You can find that panel tab in some work areas.

It's quick to submit a scheduled process with the bare minimum steps. But there are many additional options you can set, for example, if you want to run the process on a schedule.

Select the Scheduled Process and Define Parameters

Here's what you do:

1. Click Navigator > Tools > Scheduled Processes.
3. Leave the type as Job, select the process that you want to submit, and click OK.
4. In the Process Details dialog box, enter at least the required parameters, if any.
   - Some processes have no parameters at all.
   - Some parameters depend on other parameters. For example, date range parameters might appear only after you select By Date for another parameter.
5. Click the Advanced button if you want to define the schedule, notifications, or output. Continue to the next steps. Or, just skip to the steps for finishing the submission, to run the process once as soon as possible with the default output.
Define the Schedule

Set up a schedule to run the process on a recurring basis or at a specific time. Use the Process Details dialog box in Advanced mode.

1. Open the Schedule tab and select **Using a schedule** for the Run option.
2. Select a frequency.
   - Select **User-Defined** if you want to enter the exact dates and times to run the process.
   - You can select **Use a Saved Schedule** to use an existing schedule, if there are any.
3. Depending on the frequency, define when the process should run.

Some processes can't be run more often than a certain frequency, for example more than every 10 minutes. But there are some situations where that validation doesn't apply, for example, when different users run that same process less than 10 minutes apart. Or, if you use a saved schedule that has an individual run in addition to the regular frequency, for example a schedule that runs every 10 minutes and once at five minutes after the first run.

Define the Output

You can choose the layout, format, and destination for your output. Use the Process Details dialog box in Advanced mode.

1. Open the Output tab, if available.
2. Click **Add Output Document**.
3. Change the name if you want. The name identifies this output document when you go to view output later.
4. Select a layout if you have more than one to choose from.
5. Select a format, for example one of these:
   - **PDF**: Is the best option if you want to print the output.
   - **Excel**: Supports embedded images, such as charts and logos, but can be opened only in Excel 2003 or higher.
   - **Data**: Gives you report data in an XML file, which is used mainly for editing the report layout.
6. Click **Add Destination** to send the output somewhere, for example to a printer or email address. You can add many destinations and send the output to all of them at the same time.
   
   **Tip**: You can also print the output as part of the steps for finishing the submission, instead of adding a printer destination here.
7. To add more output documents, repeat steps 2 to 6.

Set Up Notifications

You can have notifications sent out depending on how the process ends. Use the Process Details dialog box in Advanced mode to set that up.

1. Open the Notification tab.
2. Click **Create Notification**.
3. In the **Recipient** field, enter the user ID of the person you want to send the notification to.
4. In the **Condition** list, select when to send the notification, for example when the process ends in error.
5. Click **OK**.
6. To send notifications to more people, repeat steps 2 to 5.
Finish the Submission

Follow these steps in the Process Details dialog box:

1. Click the Process Options button if you want to define settings that affect the data to be processed.
2. If the process gives you output and you want to print it, select the Print output check box and a printer.
3. Select the Notify me when this process ends check box if you want to get an email notification.
4. Enter submission notes to capture any information you want to associate with this submission. You can use your notes to find this submission later.
5. Click Submit.
6. Click OK to confirm.

Tip: Note down the process ID for your submission so you can easily find it later. For example, let’s say you set the process to run once a week. If you later want to cancel all runs on this schedule, you need to cancel this original submission with the process ID you see.

Submit Process Sets

To submit a process set from the Scheduled Processes Overview page:

1. Proceed with the steps that you would follow to submit any scheduled process, but select Job Set for the Type option.
2. In the Process details dialog box, set parameters for individual processes in the set. A process set itself doesn't have parameters.
   a. Select a process on the Processes tab.
   b. Enter parameters for that process, if any.
   c. Repeat for other processes in the set.
3. Define the schedule, output, and notifications for the process set, as you would do for any scheduled process.
4. Set any other options and click Submit.

Related Topics
- View Analytics, Reports, and Dashboards

Examples of Process Options

When you submit scheduled processes, click the Process Options button in the Process Details dialog box to set options such as language and time zone.

- Your settings affect the data to be processed and what you get in the output
- If the process is running on a schedule, your settings apply to every run.
- The settings override what’s set in general preferences, which you can get to by clicking your user name in the global header and selecting Set Preferences.

Let’s take a look at some examples of process options that you can set.

Language

You set the language process option to Spanish, while the Current Session field is set to Japanese in your general preferences. So, your output is in Spanish. If you don’t set the language process option, the output is in Japanese.
Currency
You set the currency process option to Euro, while your general currency preference is set to Yen. The scheduled process makes calculations based on the Euro, and the output shows all monetary amounts in Euro.

Example of Process Details for a Process Set
When you’re submitting a process set with the Process Details dialog box, you can open the Processes tab to see what’s in the process set. There’s a list of all the jobs in the job set that the process set is based on. Every job and job set in the job set that you’re submitting is considered a step and has a unique step ID.

- The Path column shows the step ID of the job, preceded by the step IDs of its parent job sets.
  
  Tip: If a job shows up more than once in the process set, use the path information to differentiate between those instances.

- The Job Set column shows the direct parent of each job in the process set.

Scenario
Let’s try to understand what we are looking at in the Processes tab. Say you’re submitting a process set based on a job set called Full Cleanse and Import, which contains a job set and two jobs, with one of the jobs showing up twice:

- Clean Records job (with a step ID of CleanRec1)
- Quick Import job set (QuickImpo1), which has two jobs:
  - Import Records job (ImpoRec1)
  - Clean Records job again (CleanRec1)

This table shows what we see in the Processes tab for this example.

<table>
<thead>
<tr>
<th>Job Definition</th>
<th>Path</th>
<th>Job Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Records</td>
<td>CleanRec1</td>
<td>Full Cleanse and Import</td>
</tr>
<tr>
<td>Import Records</td>
<td>QuickImpo1.ImpoRec1</td>
<td>Quick Import</td>
</tr>
<tr>
<td>Clean Records</td>
<td>QuickImpo1.CleanRec2</td>
<td>Quick Import</td>
</tr>
</tbody>
</table>

Manage Processes and View Output
### Statuses of Scheduled Processes

After you submit a scheduled process, it can go through many statuses until it reaches a final state. This table explains the statuses you might see. The Action Required column tells you if something can be done for the process:

- **No (in progress):** The process was submitted and hasn't reached a final state yet. But you or administrators don't need to do anything to move the process along.
- **Yes:** You or administrators need to do something to get the process to another status.
- **No (final):** The process has reached a final state, and nothing else can be done.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
<th>Action Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blocked</td>
<td>At least one other running process is incompatible with and currently blocking your process. The situation will be automatically fixed.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Canceled</td>
<td>The process was canceled, and you can't restart it.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Canceling</td>
<td>The process is currently moving to the Canceled status.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Completed</td>
<td>The main part of the process completed, and postprocessing (such as sending notifications and generating output) has started.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Error</td>
<td>The process finished running and ended with errors.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Error Auto-Retry</td>
<td>The process ended with errors but will automatically run again.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Error Manual Recovery</td>
<td>The process ended with errors and requires an administrator to move the process to a final state.</td>
<td>Yes</td>
</tr>
<tr>
<td>Expired</td>
<td>The process didn't run and its schedule already ended. You can't restart it, but you can resubmit with the same parameters or submit a new process.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Finished</td>
<td>The process ran based on a schedule, and it's either a process set or a process that causes other processes to automatically run. Either way, all processes involved are done running.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Status</td>
<td>Description</td>
<td>Action Required?</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Hold</td>
<td>The process is put on hold and needs someone to release it before it can continue running.</td>
<td>Yes</td>
</tr>
<tr>
<td>Paused</td>
<td>The process is paused so that another process that was automatically kicked off can run first.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Pending Validation</td>
<td>Some validations, for example related to security, are performed on the process before it runs.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Ready</td>
<td>The process passed validation and is about to start running.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Retrying</td>
<td>The process resulted in an error but will try again. It will automatically rerun at the time you see in the Scheduled Time column on the Scheduled Processes Overview page. The number of retries depends on how the job is set up. After all the retries, if the process still can’t run successfully, it will end with the Error status.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Running</td>
<td>The main part of the process is currently running.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Schedule Ended</td>
<td>The last submission in a schedule has happened for a process that’s either a process set or a process that causes other processes to automatically run. Either way, all processes involved have started running, but might not be done yet.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Succeeded</td>
<td>The process successfully completed.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Validation Failed</td>
<td>The process failed validation.</td>
<td>No (final)</td>
</tr>
<tr>
<td>Wait</td>
<td>The process passed validation but isn’t running yet.</td>
<td>No (in progress)</td>
</tr>
<tr>
<td>Warning</td>
<td>The process finished running and ended with a warning, for example, that a notification wasn’t sent.</td>
<td>No (final)</td>
</tr>
</tbody>
</table>
View Status and Other Details for Scheduled Processes

After you submit a scheduled process, you can track its progress. Processes can finish running in seconds, or a few minutes, or even longer. If something interrupts a process while it’s running, for example a server restarting, then the process automatically picks up where it left off. If you need to see all processes, not just the ones you submitted, ask your security administrator to assign you a custom role that has the ESS Monitor Role (ESSMonitor) or ESS Operator Role (ESSOperator).

Here’s where you can find processes that were submitted:

- Scheduled Processes work area
- Other work areas with a section for scheduled processes, if available

Here’s an example of the section that you can find in some other work areas.
Check the Status in the Scheduled Processes Work Area

Here’s how you find your scheduled process and see how it’s doing.

1. Click **Navigator > Tools > Scheduled Processes**.

   The Search Results table shows processes that match the default saved search, **Last 24 hours**.
   - The table might be blank if nothing was submitted.
   - If submission notes were entered when submitting the process, you can use the **Submission Notes** column to help identify the process.

2. If you don’t see the process, click the **Refresh** icon or use the Search section.

   - For the search, enter your own criteria or select another saved search, including these:
     - Last hour
     - Last 48 hours
     - Last 72 hours
     - Cancelable Processes
   - Refresh the search results at any time to see the latest status of the process in the **Status** column.

3. Do any of these tasks to check on the progress of the process:

   - For more details about the status, click the status link. For example, if a process is in the Ready status, you can click the **Ready** link in the **Status** column to see where the process is in the submission queue.
   - Check the **Start Time** column to see if the process has started running yet.
   - In the Search Results table, find the **This Job's Items Processed / Errors / Total** column. For some scheduled processes, this column shows what's getting processed and how things are going. For example, if the value is **Lines 50/2/?**, then this is what that means:
     - The scheduled process is processing lines, for example lines from a file that’s getting imported.
     - 50 lines are successfully processed.
     - Two lines ended up in error.
     - The total number of lines to process is unknown right now. If 100 was displayed instead of the question mark, that would mean there are 100 lines in total, 52 of which are already processed, and 48 more to go.
Even after the scheduled process reaches a final state, the first two numbers might not add up to the total, for many reasons. For example, if you cancel the process before it's done, then not all items got processed. Or, you have set a process parameter to end the process if at least 50% of the items getting processed ends in error. In which case, the scheduled process itself could still successfully end, but not everything was actually processed.

○ Click the **View Log** button, especially if your process has a blank **This Job's Items Processed / Errors / Total** column. The type of information in the log varies, depending on the process. You can open the log from here only if the process is currently running. When the process is done, you might want to also take a look at the final log, if any, from the Details section.

**View Other Details in the Scheduled Processes Work Area**

To get more information about a scheduled process, select it in the Search Results table and see the Details section that appears after the table. These are some of the details you might find:

- Completion text, which is automatically generated when the process reaches a final state. What you see depends on the process. For example, it might say that the process finished 1792 records in less than a second.
- The log attachment, for example for details about why the process ended in error.
- Report output that the process generated, if any.
- Parameters for the scheduled process.
  ○ Open the Parameter Names with Values subsection to see the parameters from the Process Details dialog box and the values that were entered when the process was submitted.
  ○ Use the All Parameter Values subsection for troubleshooting purposes, if you need to see the parameters and values in their actual, technical format. This subsection might have more parameters. For example, some processes run with additional parameter values that are derived from the parameter values you entered when you submitted the process.

**Monitor Scheduled Processes in Other Work Areas**

Some work areas have a section where you can monitor the scheduled processes that were already submitted.

1. Go to the section if it’s available, usually on the landing page of the work area.
2. Click the **Refresh** icon if you don’t see any processes or need to see the latest status.
   ○ If you still don’t see the process you’re looking for, try changing the filters. If that doesn’t help, use the Scheduled Processes work area instead.
   ○ If submission notes were entered when submitting the process, you can use the **Submission Notes** column to help identify the process.
3. Do either of these things to check on the progress of the process:
   ○ For more details about the status, click the status link. For example, if a process is in the Ready status, you can click the **Ready** link in the **Status** column to see where the process is in the submission queue.
   ○ Check the **Start Time** column to see if the process has started running yet. If it has, you can click the link in the **View Log** column to get information about how the process is running.

**Cancel or Make Changes to Scheduled Processes**

Life is full of second chances! After a schedule process is submitted, you can still cancel it or make other changes in the Scheduled Processes work area. What you can do to the process depends on its status. Also, depending on what you have access to, you can even work on processes that someone else submitted. If you need to cancel processes that
someone else submitted, ask your security administrator to assign you a custom role that has the ESS Administrator Role (ESSAdmin).

Make Changes to Processes
Select the scheduled process in the Search Results table.

- If the process hasn't started running yet, you can still use the Actions menu to change the schedule or output.
  - Edit Schedule: Change the submission schedule, for example to submit it biweekly instead of weekly.
  - Edit Output: If the process generates output, you can change output options, for example from HTML format to PDF.
- If the process is running, you can click Put On Hold to pause it, or Release Process so that a process that's on hold continues to run.

Cancel a Process
Select the scheduled process in the Search Results table, and click Cancel Process.

If you submitted a process to run on a schedule, for example once a day, you can cancel the scheduled runs even if some of the runs already happened. Find the original submission, the row with the process ID you got when you submitted the process. The status should be Wait. When you cancel this original submission, you cancel any current and future runs based on the schedule you had set.

Sometimes it takes a while for a process to finish canceling. So, you can use the Actions menu to end it. The option you get depends on the process.

- Hard Cancel: To end the process shortly after you canceled it, without waiting for the cancellation to finish by itself.
- Force Cancel: To end a process that has been canceling for over 30 minutes but isn't done yet.

Some processes run on a remote server. When you click Force Cancel, even though the status is changed to Canceled, the process might still be running on the remote server. With the scheduled process still selected in the Search Results table, you check the status of the remote process in the Details section that appears after the table. The Remote Status field might display any of these statuses for the remote process (not for your scheduled process):

- Completed Successfully: The remote process was successfully canceled within the 30 minute grace period.
- Running/Unknown: Your scheduled process is in a Canceled state, but the remote process is still running.
- Terminated: Your scheduled process is in a Canceled state, and the remote process is successfully canceled after the 30 minute grace period.

Cancel Processes in Bulk
You can cancel up to 100 processes at once, as long as the processes haven’t reached a final state.

1. Click Navigator > Tools > Scheduled Processes.
2. In the Search section, select Cancelable Processes from the Saved Search list.
3. Make sure that what you get in the Search Results table meets these requirements:
   - No more than 100 processes
   - Only processes with a cancelable status:
     - Wait
     - Ready
     - Running
- Completed
- Blocked
- Hold
- Paused
- Pending Validation
- Schedule Ended
- Error Auto-Retry

4. Use the Search section to change your search results, if you need to.
5. Select **Cancel Processes in Bulk** from the **Actions** menu.

**View Output from Scheduled Processes**

Other than processing records, some **scheduled processes** also give you output. When you submit the process, you can select the output layout and format, and set other output options. In the Scheduled Processes work area, you can view the output and even republish it in a different format without resubmitting the process. You might be able to see the output from other work areas too.

**When You're In the Scheduled Processes Work Area**

Here's what you do:

1. Click **Navigator > Tools > Scheduled Process**.
2. Find your scheduled process and, if you need to, refresh the search results to see the latest status.
3. Select the scheduled process.
4. Go to the Output subsection in the Details section.
5. Click the link in the **Output Name** column to view or download the output, which you can then print.
6. To view or export the output in a different format:
   a. Click the **Republish** button.
   b. Click the **Actions** icon.
   c. Select **Export**, and then select a format.

   **Tip:** If you want the Data format, you can just click the **XML Data** icon instead.

**When You're In Other Work Areas**

Some other work areas have a section, usually on the landing page of the work area, where you can monitor the scheduled processes that were already submitted. In the table there, find your process and click the **Output** icon in the **View Output** column.

**Resubmit Scheduled Processes and Process Sets**

You can easily resubmit **scheduled process** using the exact same parameter values, if the process has a Succeeded status and wasn't part of a submission involving other processes. For **process sets**, you can also resubmit after changing any of the parameters or other options.
Resubmit Processes

In the Scheduled Processes work area, here's how you resubmit processes using the same parameters:

1. Click **Navigator > Tools > Scheduled Processes**.
2. In the Search Results table, select your process and take a look at its details, including parameter values.
3. Click **Resubmit**.

Some other work areas have a section, usually on the landing page of the work area, where you can monitor the processes that were already submitted. In the table there, you can also select your process, see its parameter values, and click the **Resubmit** button.

Resubmit Process Sets

Resubmit process sets from the Scheduled Processes work area, not other work areas.

1. Click **Navigator > Tools > Scheduled Processes**.
2. See process details, including parameter values, for the processes that ran as part of your process set.
3. In the Search Results table, select your process set.
4. Click **Resubmit**, and you're done. Or, click the **Resubmit** drop-down button and select **Resubmit with Changes**.
   a. In the Process Details dialog box, select a process on the Processes tab.
   b. Change any of the parameters.
   c. Repeat and change parameters for any of the other processes in the process set.
   d. Define anything else as part of the submission, for example the schedule.
   e. Click **Submit**.

Both options to resubmit are available for process sets in either of these situations:

- Has any of the statuses in a final state, for example Succeeded or Canceled
- Ran based on a schedule and has either the Wait or Schedule Ended status

FAQs for Scheduled Processes

What do I do if I can't find scheduled processes that were already submitted?

Some of the work areas where you do your business tasks might have a section you can use to monitor scheduled processes. If the process you're looking for here was submitted before anything in the Time Range filter, then go to the Scheduled Processes work area (**Navigator > Tools > Scheduled Processes**). There, you can set the Submission Time criterion, for example, to search for processes that were submitted after a certain date or between the dates you specify.

If you're in the Scheduled Processes work area and still can't find your process, check if you've noted somewhere when the process was submitted or when it ran. Processes that finished a while ago might not be available any more. Processes can be kept for at most 60 days, but it might be much shorter, for example 7 or 15 days.
Why are scheduled processes shown in a hierarchy?

A scheduled process with child nodes might be a process set. The hierarchy shows you the structure of nested processes or process sets within that process set.

Or, when a scheduled process runs, it might cause other processes to run automatically. So those other processes are child nodes for the original process.

How can I export search results for scheduled processes to a spreadsheet?

Here's what you do:

1. Click Navigator > Tools > Scheduled Processes.
2. On the Overview page, expand the Search section and run your search.
3. If you're happy with the search results, click the Download Results button in the Search section.
4. In the Download Results dialog box, select the number of records you want to export.
5. Select the Include Job's item count check box to include the This Job's Items Processed / Errors / Total column in the spreadsheet.
6. Click Download.

Tip: If you see any difference between the spreadsheet and the Search Results table, refresh the table and then compare again.

Where to Find Information About Specific Scheduled Processes

Here's some information about specific scheduled processes that you might have access to, depending on the products you're using and the roles you have. This isn't a comprehensive list of all available processes.

- Common features
  See: Where to Find Information About Common Scheduled Processes
- CX Sales and B2B Service
  See: Where to Find Information About CX Sales Scheduled Processes
  See: Where to Find Information About B2B Service Scheduled Processes
  See: Where to Find Information About All Common CX Scheduled Processes
- Supply Chain Management
  See: Where to Find Information About SCM Scheduled Processes
Where to Find Information About Common Scheduled Processes

Here are many of the scheduled processes that are available as part of common features.

Approvals and Workflow

- Extract Workflow Tasks for Archive
  See: How Workflow Tasks Are Archived and Purged
- Process Translation Workflow Tasks for Archive
  See: How Workflow Tasks Are Archived and Purged
- Refresh Transaction Administrator Console Transaction Status
  See: Manage Workflow Transactions
- Synchronize Notifications in Global Header
  See: Synchronize Notifications in the Global Header and Home Page with Workflow Tasks
- Upload Workflow Task Attachment for Archive
  See: How Workflow Tasks Are Archived and Purged

Business Intelligence

- Create Rules XML File for BI Extender Automation
  See: Overview of the Essbase Rule File and Cubes
- Import Oracle Fusion Data Extensions for Transactional Business Intelligence
  See: Overview of Flexfield Change Import

Flexfields

- Upload Value Set Values
  See: Upload Value Set Values Process

Security

- Import User and Role Application Security Data
  See: Configure the Security Console
- Inactive Users Report
  See: Inactive Users Report
• Locked Users
  See: View Locked Users and Unlock Users

• Retrieve Latest LDAP Changes
  See: Retrieve Latest LDAP Changes

• Send User Name and Password Email Notifications
  See: How can I notify users of their user names and passwords?

• User and Role Access Audit Report
  See: User and Role Access Audit Report
10  Transactional Business Intelligence (OTBI) Analyses, Dashboards, Reports, and Infolets

Reporting and Analytics: Overview of Analyses, Dashboards, Reports, and Infolets

In OTBI reporting and analytics, you analyze business intelligence analyses, dashboards, and reports to gain insight that you can act on and use to meet specific requirements. You can use different types of predefined analytics, dashboards, reports, and infolets or create and edit them to support your business needs.

Analyses, Dashboards, and Reports

There are three main objects you use to analyze your data and business.

<table>
<thead>
<tr>
<th>Object</th>
<th>What It Displays</th>
<th>What You Use It For</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis</td>
<td>Data in an interactive format, for example a table or graph.</td>
<td>Summarize or break down simple, real-time data, which helps you in taking short-term decisions.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>A collection of analyses and other content, presented on one or more pages, or tabs.</td>
<td>Get various pieces of information about a particular subject.</td>
</tr>
<tr>
<td>Report</td>
<td>Data in a predefined format that provides little or no interaction.</td>
<td>Get high-volume data in a high-fidelity output optimized for printing, for example in documents to support internal operations, statutory requirements, and other business needs.</td>
</tr>
</tbody>
</table>

Note: You can export tables on UI pages to Microsoft Excel workbooks, where available, and use the exported data for analytical purposes.

For more information, see the Creating and Administering Analytics and Reports guides and the Using Analytics and Reports guides (if available) for your products.

Create and Edit Analytics and Reports

You can create and edit analytics and reports for your own use, or make changes to objects for others, if you have the appropriate roles to do so.
Here are a few examples of the changes you can make.

- Add or remove columns from an analysis.
- Change the branding logo on report output.
- Create a dashboard to include your most commonly viewed analyses.

For more information about creating and editing analytics and reports, see the Creating and Administering Analytics and Reports guides for your products.

View Analytics, Reports, and Dashboards

There are different ways to view and work with your analytics and reports. You can view analyses, dashboards, and reports in the course of your work, on your usual pages and infolets. Or you can find them in the business intelligence catalog with the Reports and Analytics work area and the Reports and Analytics panel tab.

View Analytics in Infolets

Use your favorite infolet pages to find analytics.

1. Use the page controls and Previous and Next icons to explore infolet pages in the home page, where they may appear in infolets with summaries and aggregations or performance metrics. You may also find infolets in some work areas.
2. Click an infolet to open a detailed analysis. So for example, if an infolet has transactions summed to a total, click it to view details of the underlying transactions.
3. Click Done.

View Objects in Familiar Work Areas and Pages

Use analyses, dashboards, and reports available in your usual pages and work areas.

1. Explore your pages. Some may include analysis and report links or embedded objects, sometimes in tabs or panel tabs.
2. Some work areas have a Reports and Analytics panel tab, where you explore catalog folders for relevant analyses and reports for the work area. And if you have permission, you can map more objects to the work area if they're appropriate.
   a. Open the panel tab.
   b. Expand the Shared Reports and Analytics folder and explore the available content.
   c. Click the link for any object and see its type to determine whether it's an analysis, a report, or a dashboard.
   d. Click View to open the object.
View Objects in the Reports and Analytics Work Area

Use the Reports and Analytics work area to search or browse the catalog and view any analysis, dashboard, or report you have access to. It opens at the highest level of the catalog’s folder hierarchy with all objects you have marked as favorites.

Here are some things you can do in the Reports and Analytics work area.

1. Click Navigator > Tools > Reports and Analytics.
2. Filter and search for objects:
   a. From the Filter list, select what you want to find.
   b. To view objects you have marked as favorites, select Favorites in the list. Or select Recent Items to view objects you recently worked with, or a recent search to run it again. Enter a name or part of a name and click the Search icon.
   c. In the search results, use the icons to identify what the objects are.
   d. Click the name of an object to open it, or click More and select an action.
3. In the breadcrumbs, browse the catalog folders for analytics and reports. Click any Hierarchical Selector icon to select a different node for the next level in the hierarchy.
4. Mark objects as favorites.
   o Select Favorites in the Saved Searches to display your favorite objects.
   o Click the Add Favorites icon for an object to mark it as a favorite.
   o Click the Remove from Favorites icon to remove an object from your favorites.
5. Create and edit analyses and reports.
   a. Click Create and select Report or Analysis.
   b. Use wizards to create your analysis or report.
6. Click the Browse Catalog button (or click the More icon for a specific report, dashboard, or analysis) to use more features.

View Analyses

An analysis queries against your company’s data and answers business questions with visualizations, such as charts and tables. They may appear on your pages, or as parts of a dashboard.

1. From the catalog folders or search results, open an analysis to view.
2. Click Refresh to rerun the analysis and refresh its data.
3. Click Print and select either Printable PDF or Printable HTML to open a printable version.
4. Click Export to get analysis data in various formats, for example PDF, Excel, PowerPoint, comma-separated value (CSV), and XML.

Note: When you export data in a CSV format, dates are exported in raw format and converted to UTC time zone.
View Grouped Analyses in Dashboards
Some analyses are grouped in dashboards to give you meaningful related information. A dashboard contains pages of analyses, prompts that filter information, and other objects.

1. From the catalog folders or search results, open a dashboard to view.
2. Select values for any dashboard prompts to filter the dashboard.
3. Click **Apply** to refine the results of all of the analyses in the dashboard.

View Reports
Reports show data in a predefined format that's optimized for printing.

1. From the catalog folders or search results, open a report.
2. Click the **View Report** icon if you want a different format.
   - Choose **HTML** or **PDF** to display the report in a format for printing. Because it's optimized for printing, PDF often provides the best results.
   - You can also export the report as RTF for editing in a word processor, or as Excel or PowerPoint.
3. From the catalog folders or search results, you can also do these tasks:
   - Click **Edit** to edit the report properties, layout, and data model.
   - Click **Report History** to see details about past submissions of the report.
   - Click **Schedule** to schedule the report to be run.

Where to Find More Information About Analytics and Reports
Here are some resources to help you get started.

- See the Analyze and Report page for your cloud services in the Oracle Help Center (http://docs.oracle.com).
  - Enterprise Resource Planning
    - See: Financials Reports and Analytics
    - See: Procurement Reports and Analytics
    - See: Project Portfolio Management Reports and Analytics
    - See: Risk Management Reports and Analytics
  - Human Capital Management
    - See: Global Human Resources Reports and Analytics
    - See: Talent Management Reports and Analytics
  - Customer Experience
See: CX Sales Reports and Analytics
See: B2B Service Reports and Analytics
See: Loyalty Reports and Analytics
  o Supply Chain Management
    See: Supply Chain Management Reports and Analytics
  o Public Sector
    See: Public Sector Reports and Analytics
- On these pages, you can review videos, guides, lists of predefined reports and analytics, and other resources for using and creating analytics and reports.

Infolets

Overview of Infolets

An infolet is a small interactive widget that gives you key information and shows you what's going on in the areas you work on. You might also find something in an infolet that you need to follow up on. You can use infolets arranged in tabs in the Analytics section of your home page. If you're using a panel or banner layout, use the page control icons to use the infolets.

Here are a few things to know about infolets.

- Infolets have a front view, and might have a back and expanded view. Use the Back View, Front View, and Expanded View icons at the bottom corners of an infolet to open these views.
- Your current infolet view persists as the default view the next time you sign in. For example, if you viewed a back view of the infolet in your last session, you will see the same infolet view by default in your next session.
- Some infolets might also contain links to detailed reports. You can click anywhere in the infolet area to drill down to the detailed report.
- You can also personalize the infolets. For example, you can move or hide them on the infolets page.
- If you don't see infolet pages on your home page, then your administrators must have disabled them to show on the home page.

Note: Some SCM or Procurement Cloud infolets might function differently from other infolets.
Here's how an infolet page looks.

![Infolet Page Example](image)

### Personalize Infolets

You can personalize the infolets on your infolets page, such as you can edit their titles and views, move them, or hide or show specific infolets on the infolets page.

#### Edit Infolet Titles and Views

1. Click the **Actions** icon on the top right corner of the infolet, and select **Edit Title and Views**.
2. Edit the infolet title, and enable or disable the infolet views.
3. Click **Save and Close**.

#### Reorder Infolets

You can change the position of an infolet within an infolet page.

1. Click the **Infolet Repository** icon, and select **Reorder Infolets**.
2. In the Reorder Infolets dialog box, select the infolets, and use the arrows to reorder them.
   - **Tip**: To select multiple infolets, press the Ctrl key, and then select them.
3. Click **Apply**.

#### Hide or Show Infolets

To hide an infolet from an infolet page, click the **Infolet Repository** icon, and deselect the infolet from the list of infolets.

- **Tip**: Alternatively, click the **Actions** icon on the top right corner of the infolet, and select **Hide**.

To show a hidden infolet on an infolet page, click the **Infolet Repository** icon, and select the infolet from the list of infolets.

### Related Topics

- Configure Infolet Display
- Why don't I see infolets in the Analytics section of the home page
How You Use and Personalize Infolets in Oracle SCM and Procurement Cloud

Oracle Supply Chain Management (SCM) and Procurement Cloud infolets are visual, actionable, and personalized information cards summarizing critical data about specific objects. These infolet cards are combined in a SCM or Procurement home experience or work area home page to make key performance indicators easy to view, understand, and act upon.

You can do the following with infolet cards:

- Flip or expand the card to view additional details about the object featured in the infolet card.
- Drill down to more details by navigating to relevant manage pages from the infolet view.
- Change the context of the card either at page level or at view level.
- Hide infolet cards.
- Reorder infolet cards.

Flip and Expand Card

Some infolet cards have a back view or an expanded view that provides additional information relevant to specific aspects of the object being featured in the infolet card. The back and expanded views of the infolet card display additional levels of detail and expose useful information relevant to the object. Based on how the infolets have been configured, you can then navigate to either the back view or the expanded view.

To see different views of the infolet card, do the following:

- Click the Back View icon present on the infolet card to see the back view with additional information about the object.
  - To return to the front view, click the Front View icon present on the infolet card.
- The expanded view is available from either the front view or the back view. Click the Expanded View icon to see useful information about the objects. Click the Front View or Back View icon to return to the view you started with.

Additional Pages

Click the number or an element like a segment on the pie chart of the infolet card to navigate to relevant manage pages with additional, in-context information. Drill down to view additional relevant information on related objects that will help you to act on the latest and critical data points. For example, suppose you have an infolet card that displays draft orders with errors. Each number or the segment of the graphical element represents the different error conditions such as pricing errors, processing constraint errors, and so on. Click the segment that represents draft orders in pricing errors to see the names and additional details of all the draft orders with pricing error.

Context Selector

To view different perspectives of the same data, use context selectors. Two types of context selectors are available: at the page level, and at the view level. Only some of the infolet cards have the view-level context selectors, while only some pages with infolet cards have page-level context selectors. Context selectors aren't present on all infolet cards and
If you change the context of the card on any view of the card, these changes may not necessarily reflect on the alternate views of the infolet card.

- Each view of the infolet card may have a view-level context selector located after the title of the card. Select from the list of available contexts and the view is updated based on that context. The view-level context can be different on each view of the card.

  For example, you may have an infolet card that displays information about fulfilled orders for different time periods. Use the context selector to see information about orders that were fulfilled in the last three months.

- The page-level context selector is available on a tool bar of the page. The page-level context selector is similar to the view-level context selector, except that all the cards on the page will display data as per the filters set in the page-level context list. Click the View By icon on the tool bar of the page. Select the contexts from the two available lists in the Page Context dialog box.

  Examples include updating all of the cards to show data only for the last week, or only for a particular business unit.

Hide Card

Click the Actions icon present on the infolet card, and select Hide. The selected card is hidden. You can also hide cards by clicking the My Infolets icon present on the page. A list of infolet cards is displayed. Deselect the check box of the infolet card that you want to hide.

Rearrange Cards

The infolet cards can be moved around and can be rearranged or re-ordered on the page in any way you want.
11 Social Network

Why should I care about social networking in my application?

Wouldn’t it be great if you could instantly share an aspect of your application with everyone who plays a part in getting the job done? Without having to start an untold number of e-mail threads that then get forwarded to other people, until it’s impossible to know who’s in charge of what?

When you share a business object with the social network - like a Sales Opportunity or a Purchase Order - you create a Social Object. With the Social Object, you can bring all your stakeholders together in a single place to get the collaborative ball rolling and keep a record of everything that has transpired. So, new folks can easily jump in and come up to speed.

What does social networking have to do with my job?

Social networking isn’t just for social situations anymore.

Here are some key reasons for using social networking in your business applications:

- In a business object, open Conversations on the spot and discuss details while looking at them. No worries about keeping two sets of data synchronized. The details you see in your social network are the same you see in your business application.
- All communications are organized automatically by business object, so no wasted time with filing and searching through e-mails.
- Quickly engage resources as needed to address issues or solve problems. Invite new members to the Conversation so that they can easily see the complete history.
- Share presentations and other documents, and get inputs from other team members. Web conference not required. Juggling e-mail responses not required.
- Get real-time notifications about updates to key Conversations.
- Develop and expand your professional network.
- Connect and engage with others covering the same industry, product specialization, or geography.

Where to Find Information About Social Networking

Social networking includes many features to make collaborating on projects easier.

You can use Oracle Social Network features in:

- Oracle CX Sales
- Oracle B2B Service
- Oracle Global Human Resources Cloud
• Oracle Financials Cloud
• Oracle Procurement Cloud
• Oracle Project Portfolio Management Cloud
• Oracle Risk Management Cloud
• Oracle Supply Chain Management Cloud
• Oracle Talent Management Cloud

Get Started
• View social activity surrounding business objects.  
  See: How do I get to Oracle Social Network?
• Get an overview of recent social activity, keeping you up to date on the business objects you’re interested in.  
  See: How do I use the Oracle Social Network user interface?
• Share a business object in the social network to enable easy collaboration with the appropriate people.  
  See: How do I share or join a Social Object in the social network?

Post and Upload Content
• Start a Conversation about a business object, posting messages and sharing documents with everyone involved.  
  See: How do I start a Conversation?
• Post, reply to, and like messages to participate in Conversations.  
  See: How do I post a message?
• Upload documents to get comments and annotations from others.  
  See: How do I upload a document?

Interact With Others
• Connect with others in the social network to follow their activity and communicate with them directly through one-on-one Conversations.  
  See: How do I view a person's profile or interact with someone in Oracle Social Network?
• Create groups to make sure you include all the appropriate people in your Conversations.  
  See: How do I create a group?
• Flag people to bring their attention to important messages.  
  See: How do I assign flags to others?

Organize and Find Content
• Create collections to group associated business objects, Conversations, people, and groups.
See: How do I create a collection?
• Use search, hashtags, and favorites to easily find content.

See: Finding Content

Access Your Social Activity
• Download other clients to access your social activity from Microsoft Outlook, your desktop, or your mobile device.

See: How do I get to Oracle Social Network?
12 Audit

Audit History

You can use audit history to view changes to the application data, such as the business objects that were created, updated, and deleted. You must have a role with the assigned privilege View Audit History (FND_VIEW_AUDIT_HISTORY_PRIV) to view the history or to create a report. For appropriate assignment of roles and privileges, check with your security administrator.

To open the Audit History work area, click **Navigator > Audit Reports**.

The default search displays a summary of the audit history in the search results table, with key data such as date, user, product, event type, business object type, and description. If you want a detailed report, search again with modified search criteria. You can export the report summary to Microsoft Excel.

**Note:**
- When existing records are updated, the Last Update Date indicates when the changes were saved. For new records, the Last Update Date may differ from the Creation Date. That's because the Creation Date only indicates when the record creation began, and not when the changes were saved. That's why, for auditing purposes, the Last Update Date is of importance, irrespective of the difference between the Creation Date and the Last Update Date values.
- If the report contains more records but weren't displayed because of the set limit, you would see this message in the last row of the report:
  
  Results were limited to xxxx no. of rows. Contact your administrator to reset the limit, or refine the criteria and search again.

Follow the suggestion given in the message and run the report again to view all the records.

This table lists the search parameters used and the outcome of their selection in the detailed report.

<table>
<thead>
<tr>
<th>Search Parameter</th>
<th>Result of Selection</th>
</tr>
</thead>
</table>
| Business Object Type              | • Narrows the search results to that specific business object within the selected product.  
|                                   | • Enables the Show Attribute Details check box.                                      |
| Include Child Objects             | Displays all the child objects that were listed for that business object when audit was set up. For example, a sales order object that contains several items as child objects.  
|                                   | The objects are displayed at the immediate parent-child level only. To view the children at subsequent levels, select the child object as the business object type and search again. |
| Show User-Related Details         | Displays the user ID, and the name and ID of the impersonator who modified the objects during an impersonation session. |
### Search Parameter vs. Result of Selection

<table>
<thead>
<tr>
<th>Search Parameter</th>
<th>Result of Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Attribute Details</td>
<td>Enables the attribute list so that users can select either all attributes or a specific attribute to view the changes. Based on the selection, the search results indicate whether the attribute is created, updated or deleted, and the corresponding old and replaced values.</td>
</tr>
<tr>
<td>Show Additional Object Identifier Columns</td>
<td>Displays the instances (contexts) in which the business object was used. The context values identify the objects and the transactions in which they were used. Each context is unique and assigns a unique description to the business object.</td>
</tr>
</tbody>
</table>

The default report displays a standard set of columns that contain prominent details of the audit history. To view additional details, you can change the display of columns.

**Related Topics**
- Oracle Applications Cloud Securing Applications

### Types of Audit Events

In Oracle Applications Cloud, transactional events trigger the audit process based on the create, update, and delete operations.

- **Create Operation** - This event triggers audit activity whenever business object data is created and stored in the database. The audit report displays the name of the created object, the name of the user who created the object, and the time stamp.

- **Update Operation** - This event triggers audit activity whenever the existing business object data is updated. The audit report displays both the old and updated values of the object, the name of the user who updated it, and the time stamp.

- **Delete Operation** - This event triggers audit activity whenever the existing business object data is removed from the database. The audit report displays the last value that the object attributes contained and the name of the user who deleted the object.

These events trigger the audit process and the event details are stored in the audit table. Along with audit history, you can view which events triggered the changes to the object data within a given period of time. However, for events to trigger the audit process for the business objects, you must first enable the objects for auditing.

The attributes of the audited object data can be used in lookups and foreign keys to display values in the audit history. Oracle Applications Cloud supports displaying the audited information as per the application's language settings.

For Oracle Fusion Middleware products, events such as failed sign in attempts are used as triggers. In absence of an audit table, the information is stored in the sandbox and presented only in English.

**Note:** This topic focuses on the create, update, and delete event types available in Oracle Applications Cloud. For details on events used in the Oracle Fusion Middleware products, refer to the Oracle Fusion Middleware documentation.
13 Troubleshoot

Troubleshoot Issues

When you run into issues that you can't easily fix yourself, you can follow a general process to troubleshoot the issue. This process can involve error messages, diagnostic tests, recordings of the issue, and your help desk.

To troubleshoot issues, follow these steps:

1. If you get an error message, especially for a system or application error, the message might say that your help desk was notified. If so, then an *incident* is automatically created and sent to your help desk. Or, the message might advise you to contact the help desk yourself. Either way, note down the message ID that appears after the message text, and the incident ID (if any).
2. Run diagnostic tests if you have access to do so and can find tests relevant to your issue. Click your user image or name in the *global header* to open the *Settings and Actions* menu, and select *Run Diagnostic Tests*.
   - If you can't run diagnostic tests, or can't resolve the issue after looking at test results, then go to the next step.
3. Contact your help desk and provide the IDs you noted in step 1, any diagnostic test results, and anything else related to your issue.
4. If your help desk asks you to reproduce and record your issue, then click your user image or name in the global header to open the *Settings and Actions* menu, and select *Record Issue*.
5. After you finish recording, note down all the information about your recording (for example the recording ID) and send it to your help desk.
6. Continue working with your help desk to resolve your issue.

Diagnostic Tests

Run Diagnostic Tests

Use the Diagnostic Dashboard to identify and resolve issues within your application. You can run and monitor diagnostic tests and review the test results using the Diagnostic Dashboard.

To run a diagnostic test, ensure that your user account is associated with one of the following job roles:

- Application Diagnostics Regular User (ORA_FND_DIAG_REGULAR_USER_JOB)
- Application Diagnostics Advanced User (ORA_FND_DIAG_ADVANCED_USER_JOB)
- Application Diagnostics Administrator (ORA_FND_DIAG_ADMINISTRATOR_JOB)

To run a diagnostic test, do the following:

1. Click your user image or name in the *global header*, and from the *Settings and Actions* menu, select *Run Diagnostic Tests*. If you don't see this menu item, then your help desk can make it available to you.
2. In the *Search for Tests* or *Search for Tags* panes, search for and identify the diagnostic tests that you want to run.
3. From the search results, select the check box for the diagnostic test and click **Add to Run**. The selected test is added to the Choose Tests to Run and Supply Inputs table.

4. In the Choose Tests to Run and Supply Inputs table, depending on the value that appears in the Input Status column, perform the appropriate action. This table lists the values that may appear in the Input Status column and the appropriate actions for each value:

<table>
<thead>
<tr>
<th>Input Status</th>
<th>Action</th>
</tr>
</thead>
</table>
| Required Input Values Missing                    | a. Click the **Click to Supply or Edit Input Parameters** icon in the Input Status column. In the Input Parameters dialog box, specify the parameter values according to the parameter type.  
   b. Click **OK**.  
   **Note**: To skip that test and its nested test steps, deselect the **Select to Run Test** check box in the Choose Tests to Run and Supply Inputs table. |
| Required Input Values Validated or Input Values Validated | If you want to change an existing input parameter, or check the parameter values the test is currently set to use:  
   a. Click the **Click to Supply or Edit Input Parameters** icon in the Input Status column.  
   b. In the Input Parameters dialog box, review the existing parameters or specify new input parameters, as applicable.  
   c. Click **OK**. |
| No Inputs Specified                              | Proceed to step 4.                                                                                                                                 |

5. From the **View** menu in the Choose Tests to Run and Supply Inputs table, select **Availability**.

6. In the Diagnostic Test Availability dialog box, from the Select the Diagnostic Test for Details table, select each test and check the icon displayed the Availability column.
   - If the Availability column displays a check mark icon, then the selected test is currently available to be run.
   - If the Availability column displays a warning icon, or if you want to determine whether the test is internal or external, click **Detach** in the Available Details table header, and proceed to the next step.

   If all the listed tests are available to be run, and you don't need to know whether they're internal or external, proceed to Step 8.

7. In the detached table:
   - If the Details of Required Test Components column contains the name of an Oracle Fusion application, then the test is an internal diagnostic test. Otherwise, it's an external diagnostic test.
   - If the Error column contains an error message, take appropriate action to correct it.

8. Repeat steps 4 through 6 to verify that all listed tests are now available to run, and proceed to the next step.

9. Optionally, you can enter a name for your test run in the **Run Name** field in the toolbar of the Choose Tests to Run and Supply Inputs table. If you use the word **error**, or if you leave the **Run Name** field blank, the application automatically assigns the test run a name.

10. From the **Run Options** menu, select the appropriate options depending on how you want the selected diagnostic test or tests to run. This table lists the options available in the **Run Options** menu, and describes the consequences of selecting each option.
<table>
<thead>
<tr>
<th>Run Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Now</td>
<td>Runs the selected test or tests immediately after you click Run.</td>
</tr>
<tr>
<td>Run Later</td>
<td>Schedules when the test or tests are run, if this option is available.</td>
</tr>
<tr>
<td></td>
<td>When you select Run Later, the Run button on the toolbar changes to a Schedule Run button. Complete the following steps to schedule when the test or tests will be run:</td>
</tr>
<tr>
<td></td>
<td>a. Click the Schedule Run button.</td>
</tr>
<tr>
<td></td>
<td>b. In the Schedule Tests dialog box, click the Schedule tab and select Use a Schedule.</td>
</tr>
<tr>
<td></td>
<td>c. From the Frequency menu, select how often to run the selected test or tests.</td>
</tr>
<tr>
<td></td>
<td>d. In the Start field, specify the date and time at which to start testing.</td>
</tr>
<tr>
<td></td>
<td>e. Click Submit.</td>
</tr>
<tr>
<td>No Prerequisites</td>
<td>Runs the selected test or tests without running the prerequisite tests.</td>
</tr>
<tr>
<td>Run in Parallel</td>
<td>Runs the selected test or tests using multiple threads. The default value is 3, and you can select any value from 2 through 5.</td>
</tr>
<tr>
<td>Run Synchronously</td>
<td>Runs the selected test or tests using a single thread.</td>
</tr>
</tbody>
</table>

11. Click Run.

View the Status and Result of a Diagnostic Test

Use the Diagnostic Dashboard to check the status and view the results of a diagnostic test. You can review information about whether tests or test runs completed successfully, and if they detected any problems.

Check the Status of a Diagnostic Test

To check the status of a diagnostic test using the Diagnostic Dashboard:

1. Click your user image or name in the global header, and from the Settings and Actions menu, select Run Diagnostic Tests. If you don’t see this menu item, then your help desk can make it available to you.
2. After running a diagnostic test using Diagnostic Dashboard, you may need to click Refresh to display the latest status information.
3. Click the Run Status link in the Tasks pane.
4. If you want the Diagnostic Test Run Status table to display only certain types of rows, select the pertinent option from the Find list.

Alternatively, click the Search Test Runs icon to search for specific rows in the Diagnostic Test Run Status table.
5. Expand the test run nodes to view the list of executions for each test.
6. In the Diagnostic Test Run Status table, review:

   - Execution Status: This column displays status information about whether tests and test runs have completed or encountered errors.
Diagnostic Status: This column displays status information about whether the individual diagnostic tests detected any problems before completing.

View the Result of a Diagnostic Test
To view the results of a diagnostic test, click the View Test Results icon in the Report column. You can review all the details pertaining to that test.

Cancel an Initiated Diagnostic Test
Use the Diagnostic Dashboard to cancel a diagnostic test that's running.

To perform this task, ensure that you have one of the following roles:
- Application Diagnostics Regular User (ORA_FND_DIAG_REGULAR_USER_JOB)
- Application Diagnostics Advanced User (ORA_FND_DIAG_ADVANCED_USER_JOB)
- Application Diagnostics Administrator (ORA_FND_DIAG_ADMINISTRATOR_JOB)

You need the Applications Diagnostic Administrator (ORA_FND_DIAG_ADMINISTRATOR) job role to cancel tests that someone else ran.

To cancel a diagnostic test using the Diagnostic Dashboard, do the following:
1. Click your user image or name in the global header, and from the Settings and Actions menu, select Run Diagnostic Tests. If you don’t see this menu item, then your help desk can make it available to you.
2. Click the Run Status link in the Tasks pane.
3. In the Diagnostic Test Run Status table, verify that the Execution Status for the test you want to cancel is Running.
4. Select the test you want to cancel and click Cancel.

Run Diagnostic Tests to Verify, Troubleshoot, and Analyze

When you encounter an issue, you can try to diagnose it yourself by running diagnostic tests, before following up with your help desk. You can also use diagnostic tests to take preventive measures and identify potential issues before running into real problems.

| Note: You can run diagnostic tests only if you have roles that let you do so.

Health Check

This example shows running a diagnostic test to verify that data is correct before starting a large-volume task.
1. You are a general ledger manager, and you periodically run diagnostic tests to check on data, setup, and configurations, especially before closing the period.
2. You open the Diagnostic dashboard and run the General Ledger Misclassified Accounts Validations test, to make sure that all accounts are correctly classified.
3. You review the test results and confirm that the accounts are ready for the period close process.

Troubleshooting

This example shows running a diagnostic test to start the troubleshooting process.
1. You are a general ledger manager, and you run into issues with the period close process.
2. You open the Diagnostic dashboard and search for diagnostic tests using tags, with Financial Control and Reporting as the tag name.
3. You browse the search results for tests with Close Ledgers as the tag value.
4. You find and run the appropriate test, General Ledger Closing Validations.
5. The diagnostic test results can show issues that you can't fix yourself: validation errors in setup, configuration, or data integrity. In this case, it's incomplete accounting setup.
6. You notify your help desk about the diagnostic test results and describe your issue.
   If the test results had shown issues that you can't fix yourself, but didn't have validation errors, then you would ask your help desk to create an incident. The help desk would take over in the troubleshooting process.
7. Your help desk performs a fix and asks you to rerun the test.
8. You repeat steps 4 through 7 until the test completes with no issues identified.

Data Analysis

This example shows running a diagnostic test to collect data for analysis.

1. You are a purchasing buyer, and you notice unexpected data in a specific purchasing document.
2. You search in Applications Help for information related to purchasing documents, to see if you can find any relevant troubleshooting information. You find a list of predefined diagnostic tests, and you check if there is a relevant diagnostic test.
3. You open the Diagnostic dashboard and run the appropriate test, Manage Purchasing Documents Lifecycle - Validate.
4. You review the test results, which give you all the details about the particular purchasing document.
5. You see the reason for the unexpected data and resolve the issue yourself.

Analyze User Session at Run Time

Use the Application User Session Run Time diagnostic test to analyze a user's session. A session starts when users signs in and ends when they sign out.

Run this test from the Diagnostic dashboard. Click your user image or name in the global header and go to Troubleshooting > Run Diagnostic Tests.

Application User Session Cookie

Enter the cookie to identify the user session that you want to analyze.

To get the session cookie value:

1. Run the Application User Session Configuration diagnostic test to make sure that the ApplSession configuration values for your application are correct.
2. Use a valid user name and password to sign in.
3. Display the list of cookies in your browser, according to instructions for the browser.
4. In the cookies listed for your domain site, select the cookie named ORA_FND_SESSION_<DATABASE_SID>.
   a. Your domain site is the host in the URL, for example oracle.com in the URL http://example.oracle.com.
   b. <DATABASE_SID> is your database session ID.

If you can't locate the cookie, then no application user session has been created for your application.
5. See the Content field, which has the format pillar_name:session_cookie_value:timestamp. For the Application User Session Cookie parameter, enter the session_cookie_value part, which appears between two colons.
Record Issues to Troubleshoot

To help your help desk troubleshoot issues that you encounter in the application, you can record the issue while you reproduce it. Not only would the recording show your help desk what happened, but it also collects detailed data that your help desk can analyze. You can also attach additional notes and material, such as screenshots, to most recordings.

Create a Recording

Follow these steps:

1. Open the page where your issue occurred. If the issue is that a page isn’t opening or displaying properly, then you can be on any page to start the recording before you try to open the problematic page again.
2. Click your user image or name in the global header and go to Troubleshooting > Record Issue. If you don’t see this menu item, then contact your help desk or security administrator.
3. For most issues, choose to collect page diagnostics while you’re recording. Collect performance statistics only if the issue is that the application is working too slowly.
4. Open the Advanced Options section (if you’re given access) and set the recording time according to your help desk or for as long as you think it would take to reproduce your issue. You can always stop the recording as soon as you’re done.
   
   If you’re collecting page diagnostics, you can take screenshots while you record and attach them to your recording later. So take into account the time that it takes to capture screenshots.
5. If your help desk asks you to enter other advanced options, then fill out the rest of the section based on what your help desk tells you.
6. Click Start Recording to record on the current page, or on the next page that you open immediately after you click the button.
   
   If you open yet another page after that, then the recording will automatically stop.
7. Click Stop Recording or record until the allotted time runs out.
8. If you’re collecting page diagnostics, optionally add notes and attach screenshots or other relevant files to the recording.
9. Note down your recording ID, and click Submit.

Tip: You can later open the Record Issue dialog box again and click View My Recordings to find the ID and other information about this recording.

FAQs for Troubleshooting

What’s a help desk?

Your help desk might be an online tool, a team of people, or some other resource in your enterprise that assists you when you run into problems with the software you’re using. If you contact your help desk to help you fix a software error, provide the full text of the error message you received, including the message number.
What's an incident?

An incident is a collection of diagnostic information for a critical application error. This information shows the state of the application at the time the problem occurred.

If you get an error message for an issue severe enough to prevent you from continuing your work, then an incident is automatically created and forwarded to your help desk. Any diagnostic tests associated with the error message would also run automatically, with the results added to the incident. Your help desk can also manually create incidents.

How can I find information about specific issue recordings?

After you record an issue, you get a confirmation with the recording ID and other information to identify your recording. To find this same information later:

1. Click your user image or name in the global header and go to Troubleshooting > Record Issue.
2. Click the View My Recordings button.

What's the difference between the recording ID and the recording number?

The recording ID is the unique identifier for your recording of an issue. Use the ID to find your recording later, for example from a list of recordings.

The recording is stored on a server, and the recording number identifies it on the server. To get the actual recording files from the server, your help desk needs the recording number and server information.

How can I view the version information of an application?

In the global header, click your user image or name and from the Settings and Actions menu, select About This Page. The basic details about the application are visible by default. However, you must have appropriate roles to view the version and release information, and other important details about the application.

What happens when the application is in maintenance mode?

When an application is in maintenance mode, you see a message on the UI displaying either the scheduled start time or the estimated completion time of the planned maintenance activity. During the maintenance period, the background processes and tasks, such as scheduled processes or any report generation activities, are put on hold.

Also, the Setup and Maintenance work area is available in a read-only mode.

After the maintenance is completed, all modules return to their usual state.

Related Topics

- Overview of Scheduled Processes
14 Help

Get Help in the Application

Watch video

We all can use a helping hand sometimes. To get help for what you're working on, use the help icons that are on many of the pages you use. The icons open help windows that can have informational text, links to help content, or both, and maybe even include help that your company added.

Use Help Windows

Here's what you do:

1. Click a help icon. The help window gives you information specific to the page or part of the page that the icon is on.
2. In the help window, click any of the links available.
   - You see help links in your preferred language only if there's content in that language. If not, you see links in English.
   - Help content opens in a new browser tab so you can keep that open while you work.
   - You can do more with the help than just read it. Options can include printing, downloading, or emailing the help.
3. Most of the links open guides in the Oracle Help Center. You can use the Table of Contents tab to move around in the guide for other information. Or, to search within the guide, open the Search tab and run a search with the Search this book option selected, as we see here.

What to Do If You Don’t See Help Icons

If you don't see any help icons on the page, click your user image or name in the global header and select Show Help Icons. You reveal any icons on your current page, and any other page you might use, but not all pages have help icons.
In that case, click your user image or name in the global header and select Applications Help to open the Oracle Help Center.

Related Topics
- Oracle Help Center

Find Guides, Readiness Material, and Other Resources

Watch video

The Oracle Help Center (https://docs.oracle.com) has guides, videos, readiness material, and other resources for Oracle Applications Cloud.

- Guides give you cumulative information about all features in each cloud service, for example how to use, set up, and extend them.
- Readiness documents tell you what's new or changed in a particular release update. This material is published before the update happens, to help you prepare for it.

In the application, when you click links in help windows, most of the time you open a specific guide in the Help Center. From there, you can search or browse to find other content. Or, if you're on the oracle.com site, open the Resources menu and select Documentation to get to the Help Center. It's a good idea to bookmark the Help Center.

Let's take a look at how you can move around and find what you're looking for in the Help Center.

Browse for Cumulative Content About a Cloud Service

Here's how you find guides, videos, and other resources:

1. From anywhere in the Oracle Help Center, open the main menu and click Cloud Applications. Or, click Cloud Applications on the Help Center home page.
2. On the Oracle Cloud Applications Documentation page, browse the cloud services which are organized in categories.
3. Click the name of your cloud service.
4. On the main page for the cloud service, select a release update if you don't want to see the latest content.
5. Use the navigation pane to get to a specific guide, video, or other resource. Here are some examples of where you might go:
   - All Books or Videos: Get all the videos or guides for the cloud service.
     - On the Videos or All Books page, you can use the View list to filter by category.
     - Most guides are available in multiple formats, for example HTML and PDF.
   - Top Tasks: Click a task category and then a specific, common task to go straight to information that will help you with that task.
   - APIs & Schema: Get reference information about APIs and schema details.

Tip: Use the breadcrumbs to get to other parts of the Help Center.
Search Within or Across Guides

The scope of the search in the global header of the Oracle Help Center depends on the page you're on. For example, on the Oracle Cloud Applications Documentation page, you search across guides for all cloud services. On the pages for a specific cloud service, you search only within that service, which gives you more targeted results. If you want to search within one guide, use the Search tab in the guide.

Let's take a look what we can do with the search results. In this case, the first result is a guide, but you might also see other types of resources, such as videos, reference architecture and solution playbooks, or readiness material. And they might come from places other than the Help Center, for example My Oracle Support (https://support.oracle.com), oracle.com, or YouTube.

<table>
<thead>
<tr>
<th>Callout Number</th>
<th>What You Can Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Remove a filter from the search to get more results.</td>
</tr>
<tr>
<td>2</td>
<td>Apply more filters to narrow down your choices, for example based on publication date.</td>
</tr>
<tr>
<td>3</td>
<td>Open the main page for a product with a name that matches at least one of your search terms. The filters in the search field don't apply to these matches.</td>
</tr>
</tbody>
</table>
### Callout Number | What You Can Do
--- | ---
4 | See search results from this product.
5 | Open the title page for a guide with content that matches your search terms.
6 | See when this guide was published.
7 | Open a specific chapter in this guide.
8 | See more chapters in this guide.

### Review Readiness Documents

Let's find the readiness material that can help you prepare for your next quarterly update:

1. On a page in the Oracle Help Center for your cloud service, click **Cloud Readiness / What's New** in the navigation pane.
2. On the main page in Oracle Cloud Readiness for your service, find the What’s New subsection in the Essential Content section.
3. Click **HTML** or **PDF** to open a What's New document in a new browser tab.
4. Click the release update you want to review.
5. In the table of contents, click **Feature Summary** to see which features are enabled or disabled by default. You need to take action to make disabled features available to your users.
6. If you see an Opt In Expiration tab, click it to see when disabled features will become enabled by default.
7. Click the tab for your release update to go back and see the details about specific features.
8. Return to the browser tab with the main page for your cloud service to explore other readiness content. From there you can also jump over to other cloud services.

### Related Topics
- Oracle Help Center
15 Preferences

Set Your General Preferences

You can set your general preferences such as, language, currency, time zone, accessibility, and watchlist. Use the General Preferences section in the Set Preferences work area to set your general preferences. Click Navigator > Set Preferences.

Related Topics

- Set General Preferences for All Users

Set Language Preferences

Use the General Preferences: Language page of the Set Preferences work area to set your language preferences.

To set language preferences:

1. Click Navigator > Set Preferences.
2. From the Default list, select the language you want to set as the default language. Your entire application and all its elements, such as UI text, page names, and field names are displayed in this language. The input data for fields will not be translated automatically to the selected language.

   Note: If the languages you want to set aren't available on the General Preferences: Language page, contact your help desk.

3. From the Current Session list, select the language to be used in the current session until you either log off or change your language preference.
4. From the Display Name list, select the language to be used for your display name in the global header. For example, if your name is Christy, and you select Spanish for your display name, then your name will be displayed as Christie. If the equivalent of a name doesn't exist in the preferred display language, or if the display language isn't set, then the user names are displayed in the preferred default language.

Related Topics

- Set General Preferences for All Users
- Examples of Process Options

Change Your Photo

People can see your profile photo on your public information page, in the directory search results, and the global header. You can have only one profile photo at a time.

1. Go to Me > Quick Actions, and then select Change Photo action.
Note: You may also update your photo using the My Photo page in general preferences. Click your user image or name in the global header and go to Personalization > Set Preferences > My Photo.

2. Click Browse and select the photo to upload. Keep these points in mind when selecting the photo:
   ◦ The file size should be less than 20 megabytes.
   ◦ The preferable file format is .png or .jpeg though other image file formats are also supported.
   ◦ Ensure that the image dimension is 90 x 120 pixels to avoid distortion. If the image isn't of this dimension, try maintaining an aspect ratio of 3 x 4.
3. Click Save and Close.

Set Up the Accessibility Modes

You can configure the accessibility modes of the application.

1. Use either of these methods to go to the page where you can set the accessibility modes:
   a. Click your user image or name in the global header, and on the Settings and Actions menu, select either of these options:
      ◦ Access Accessibility Settings
      ◦ Set Preferences: If you select this option, click Accessibility Settings in the General Preferences section.
   b. Use the Access Accessibility Settings icon in the global header. To find the icon, keep pressing the Tab key until it appears, and then click the icon to set up the accessibility modes.
2. If you rely on screen reader assistive technologies, switch to the Screen Reader mode. Selecting this mode changes several aspects of the user interface. For example, tree components have additional columns that you can use to select specific tree nodes.
3. If you run your operating system in a high contrast mode, such as black on white, switch the color contrast to High.
4. Save your changes.

High Contrast Mode and Accessible Themes

High contrast mode works well when applied to any of the accessible themes in the application. Here’s a list of available accessible themes.

- Aquamarine
- Autumn Red
- Bright Blue
- Crisp Green
- Crisp Green Banner
- Dark Blue
- Dark Gray
- Default
- Dusty Blue Banner
• Light Blue
• Midnight Blue
• Redwood
• Sky Blue
• Sky Blue Banner
• Steel Gray
• Turquoise
• Vanilla

Related Topics
• Accessibility Features
• Overview of Application Accessibility
• Manage Themes

Change Your Password

After you sign in, you can change your password for better security.

<table>
<thead>
<tr>
<th>Note: You can't change your Single Sign-On (SSO) password using these steps.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click your user image or name in the global header, and on the Settings and Actions menu, select Set Preferences.</td>
</tr>
<tr>
<td>2. In the General Preferences section, click Password, and enter your password details.</td>
</tr>
<tr>
<td>3. Click Save and Close.</td>
</tr>
</tbody>
</table>

Proxies

Overview of Proxies

Let's say you're on vacation or busy with work, but you want to take care of some tasks. You can designate a proxy so that someone else can sign in and do the tasks on your behalf in an impersonation session.

How Impersonation Works

Your proxies can sign in using their own passwords, and start an impersonation session. They have unrestricted access to your account, except that they can't change your preferences. By default, everything your proxy does is audited. If a business object isn't set up for audit, your proxy can't work on the business object. So you can ask your administrator to disable auditing using the Audit Impersonation Transaction Enabled (FND_AUDIT_IMPERSONATION_TRANSACTIONS) profile option.

When you sign in, you can see all the work your proxy did for you. Also, you and your proxy can sign in and work at the same time.

| Note: If you're an HCM Cloud user, remember that your proxies will have access to your personal and sensitive information, such as your salary details, national IDs, and so on. |
Designate Proxies

Here’s how you can designate a proxy to work on your behalf.

1. Click your user image or name in the global header, and on the **Settings and Actions** menu, select **Set Preferences**.
2. Click **Proxies**.
3. Click **Actions > Create**.
4. Search for the person you want to designate as your proxy.

   **Note:** If you can't find the person you want to designate as a proxy, ask your administrator to check if the person has the Impersonate User (FND_IMPERSONATE_USER_PRIV) privilege.

5. Verify the user details and click **Apply**.
6. Click **OK**.
7. Select the start and end dates.
8. Click **Save and Close**.

**Related Topics**

- Work as a Proxy
- Frequently Asked Questions (FAQs) for Resources

Why can't I find a specific person to designate as my proxy?

That's because the person you want to designate as a proxy doesn't have the Impersonate User (FND_IMPERSONATE_USER_PRIV) privilege. Ask your administrator to assign the privilege to that person.

**Note:** If you’re an HCM Cloud user, remember that your proxies will have access to your personal and sensitive information, such as your salary details, national IDs, and so on.

Watchlist

Show or Hide Watchlist Items

Use the Watchlist page in the Set Preferences work area to show or hide specific items or categories in your Watchlist.

The preferences contain:

- All the predefined Watchlist categories and items available to you
- Any saved searches you're using as Watchlist items

**Set Watchlist Preferences**

Follow these steps:

1. Click your user name or image in the **global header**, and go to **Personalization > Set Preferences > Watchlist**.
2. Use the **Enabled** check box to show or hide any Watchlist item or category.

   **Note:** Disabling a category automatically hides all of its items.

3. Optionally hide enabled Watchlist items that show no records.

**Related Topics**
- How can I rename Watchlist items
- Create Watchlist Items
- Why is the count different between a Watchlist item and the page that the item link takes me to

### Why are some items not displayed in my Watchlist?

Items might be hidden based on your Watchlist preferences. These preferences also apply to saved searches that you’re using as Watchlist items. To review your preferences, select your user name or image in the *global header*, and go to **Personalization > Set Preferences > Watchlist**.

Other possibilities could be that:
- You deselected saved searches in the Manage Watchlist dialog box, so they’re no longer used as Watchlist items.
- You deleted saved searches that were used as Watchlist items.
- Your administrator disabled specific predefined Watchlist items or categories for all users.
- Your administrator disabled using saved searches (from specific pages) as Watchlist items.
- Your administrator revoked access to tasks or pages that used to be available to you.

In these cases, you can no longer see the corresponding Watchlist items in your Watchlist and in your Watchlist preferences.

**Related Topics**
- Create Watchlist Items
16 Accessibility

Overview of Application Accessibility

The application is designed with accessibility features that support assistive technologies, such as screen readers. You can use the General Preferences: Accessibility page in the Set Preferences work area to set the accessibility modes of the application. For more information about Oracle’s commitment to accessibility, see http://oracle.com/accessibility.

Keyboard Shortcuts

You can navigate the entire application without a mouse and access all relevant functionality using only the keyboard. You don’t need assistive technology to use keyboard-only navigation, which is available to all users. Keyboard shortcuts enable you to perform user interface actions without using a mouse. For example, you can use keyboard shortcuts to save a file or open a tab. Keyboard shortcuts for specific UI elements come from the Oracle Application Development Framework components that they're based on. You might also find keyboard shortcuts that are specific to a particular feature or product.

Related Topics
- Oracle’s Accessibility Program
- Set Up the Accessibility Modes

Accessibility Features

You can use assistive technology products, such as screen readers, while you work in the application. Certain components render differently in the screen reader mode. For example, date fields in the default mode have a date picker. You can either use the date picker to choose a date, or manually enter the date as text. In screen reader mode, you only enter information as text because date pickers aren't available.

You can also use a keyboard instead of a mouse. Some of the accessibility features discussed here are:

- Skip navigation links
- Additional role and state labels
- Isolated display
- Content change announcements
- Alternatives actions to drag and drop

Skip Navigation Links

When you access a page and press the Tab key, the Skip to main content link appears. Use this link to skip the global header and navigate directly to the filmstrip, which is the row of page entry icons before the page title.
Additional Role and State Labels
When you access a page in screen reader mode, the screen reader reads the labels of various user interface components such as menus and buttons, including the role and state labels. These additional labels identify the purpose and current state of the item. In some cases, the Web Accessibility Initiative - Accessible Rich Internet Applications (WAI-ARIA) standards are leveraged for role and state information.

Isolated Display
In screen reader mode, when you open a menu or a dialog box, the display is isolated on the open component until you close it. For example, when you open the Actions menu, only the Actions Menu heading and menu items are displayed. In addition to the menu item names, the isolated display provides contextual information for each item. For example, each item has Menu Item or Menu as a suffix, with the latter identifying submenus that you can open. For dialog boxes, the isolated display also provides additional information, for example to identify fields with invalid data entry.

Content Change Announcements
In screen reader mode, WAI-ARIA live regions announce changes to the application. For example, when you open or close dialog boxes, you can hear the rendering of partial content, progression of progress indicators, or changes in the menu and dialog box state.

Alternatives to Drag and Drop
Pages that provide drag and drop operations also support alternative methods of operation.
In tables where you can use drag and drop to move columns, you can select Reorder Columns from the View menu, and move(or change) the order of the selected items.

Related Topics
- Set Up the Accessibility Modes

Keyboard Shortcuts

Keyboard Shortcuts for Oracle Application Development Framework Components
The application is based on Oracle Application Development Framework (ADF) components which come with standard keyboard shortcuts. In some cases, you might find different keyboard shortcuts specific to the page, feature or product that you're using.
Oracle ADF keyboard shortcuts are described in the Oracle Fusion Middleware Web User Interface Developer's Guide for Oracle Application Development Framework.

Default Mode
- Refer to the following sections in the guide for the corresponding keyboard shortcuts.

See: Keyboard Shortcuts
Shortcut Keys for Common Components

Shortcut Keys for Widgets

Shortcut Keys for Rich Text Editor Component

Shortcut Keys for Table, Tree, and Tree Table Components

Shortcut Keys for ADF Data Visualization Components

Shortcut Keys for Calendar Component

Screen Reader Mode

The keyboard shortcuts for some components in screen reader mode are different from the shortcuts in default mode.

- Refer to the following sections in the guide for the corresponding keyboard shortcuts.

See: Keyboard Shortcuts

- Shortcut Keys for Table, Tree, and Tree Table Components in Screen Reader Mode
- Shortcut Keys for ADF Data Visualization Components in Screen Reader Mode
- Shortcut Keys for Calendar Component in Screen Reader Mode

Keyboard Shortcuts for Infolets

You can use keyboard shortcuts to operate the infolets on the home page or specific work areas. The shortcuts might be different from the ones listed in the following table depending on the selected infolet.

This table lists the keyboard shortcuts for infolets.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move focus backward among the components in the page</td>
<td>Shift + Tab</td>
</tr>
<tr>
<td>Open a context menu where available within a template in the page</td>
<td>Alt + Arrow Down</td>
</tr>
<tr>
<td>Open the different components in a chart</td>
<td>Ctrl + Arrow</td>
</tr>
<tr>
<td>Select and deselect the check box in My Infolets</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Open links except those in charts</td>
<td>Enter</td>
</tr>
<tr>
<td>Action</td>
<td>Shortcut</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Open links in the templates with charts</td>
<td>Arrow</td>
</tr>
<tr>
<td>Close dialog box</td>
<td>Esc</td>
</tr>
</tbody>
</table>

**Related Topics**

- Set Up the Accessibility Modes
Glossary

**action**
The kind of access, such as view or edit, named in a security policy.

**analysis**
A selection of data displayed in one or more views, such as a table or chart, to provide answers to business questions.

**analytics**
Business intelligence objects such as analyses and dashboards that provide meaningful data to help with decision making.

**autosuggest**
Suggestions that automatically appear for a search field, even before you finish typing your search term. You can select any of the suggestions to run your search.

**business intelligence catalog**
The repository where all business intelligence objects, including analyses, reports, briefing books, and agents, are stored. The catalog contains separate folders for personal, shared, and modified objects.

**business object**
A resource in an enterprise database, such as an invoice or purchase order.

**dashboard**
A page that gives quick access to key tasks and summary information for a business process or object.

**dashboard**
A collection of analyses and other content that gives in-depth insight to help with business decisions.

**filmstrip**
The single strip of icons that you can use to open other pages. The strip appears between the global header and the page title.
**global header**
The uppermost region in the user interface that remains the same no matter which page you're on.

**global search**
The search in the global header that lets you search across many business objects.

**incident**
A collection of diagnostic information about a critical error, providing details about the state of the application when the issue occurred.

**infolet**
A small interactive widget on the home page that provides key information and actions for a specific area, for example your personal profile. Each infolet can have multiple views.

**panel tab**
A tab that provides supplemental information or functionality for the page. Each panel tab is on the right side of the page, has an icon as the tab label, and slides out when you open the tab.
privilege
A grant of access to functions and data; a single, real world action on a single business object.

process set
A scheduled process that contains multiple individual processes or other process sets.

Query By Example
The icon for filtering data in a table.

report
An output of select data in a predefined format that's optimized for printing.

role
Controls access to application functions and data.

scheduled process
A program that you run to process data and, in some cases, generate output as a report.

work area
A set of pages containing the tasks, searches, and other content you need to accomplish a business goal.

workflow
An automated process that passes a task from one user (or group of users) to another to view or act on. The task is routed in a logical sequence to achieve an end result.